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EDATA PROJECTOR XJ-S35
Data Projector

USB Function Guide
Be sure to read the precautions in the separate User’s Guide (Basic Operation). For 
details about setting up the Data Projector and about lamp replacement, see the 
User’s Guide (Basic Operation).

Be sure to keep all user documentation handy for future reference.

• Microsoft, Windows, Windows XP, the Windows logo, and PowerPoint are registered 
trademarks or trademarks of Microsoft Corporation in the United States and other 
countries.

• Other company and product names may be registered product names or trademarks of 
their respective owners.

• The contents of this manual are subject to change without notice.
• Copying of this manual, either in part or its entirety, is forbidden. You are allowed to 

use this manual for your own personal use. Any other use is forbidden without the 
permission of CASIO COMPUTER CO., LTD.

• CASIO COMPUTER CO., LTD. shall not be held liable for any lost profits or claims 
from third parties arising out of the use of this product or this manual.

• CASIO COMPUTER CO., LTD. shall not be held liable for any loss or lost profits due 
to loss of data due to malfunction or maintenance of this product, or any other reason.

• The sample screens shown in this manual are for illustrative purposes only, and may 
differ somewhat from the screens actually produced by the product.
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About this manual...

This manual explains how to perform various operations that are enabled when you connect 
an external device to the USB port of the XJ-S35 (Data Projector).

Terms and Conventions
In this manual, there are many procedures that require parallel operations on the Data 
Projector and your computer. The following are special terms and conventions used in this 
manual to differentiate between the Data Projector and computer.
• projection area

This is the entire rectangular area that is projected by the Data Projector. Certain Data 
Projector operations will cause messages and menus to appear within the projection 
area.

• computer screen
This is the physical display device of your computer.
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About the Data Projector’s USB Functions

The USB port that is built into the Data Projector lets you connect an external USB 
device and use it as an input source for image projection.

USB Memory Device
You can connect a commercially available USB memory device to the USB port and 
project images and movies stored on the device.

Refer to the following for details.

For more information about this: Refer to this section of this manual:

Supported USB memory devices “Supported USB Memory Devices” (page 14)

Supported image and movie file formats “Supported Playback Data Types” (page 15)

Saving image and movie data to a USB 
memory device

“Preparing a Presentation with EZ-Converter” 
(page 15)

Projecting image and movie data from a USB 
memory device

“Playing a Presentation with Viewer” (page 30)

XJ-S35

USB memory device

Download from Www.Somanuals.com. All Manuals Search And Download.



7

Wireless Adapter (CASIO YW-2)
Establishing a connection between the Data Projector and a computer over a wireless LAN 
makes it possible to project the display contents of the computer’s screen from the Data 
Projector.

You can have up to four computers connected to the Data Projector over a wireless LAN 
at the same time. Use the remote controller that comes with the Data Projector to select 
which of the four computer screens you want to project.

Refer to the following for details.

For more information about this: Refer to this section of this manual:

Supported wireless LAN devices “Supported Wireless LAN Devices” (page 47)

Setup required to establish a wireless LAN 
connection between the Data Projector and a 
computer

“Wireless LAN Connection Basics” (page 50), 
“Advanced Wireless LAN Connection Settings” 
(page 62)

Projecting the screen contents of a computer 
connected via a wireless LAN

“Using Wireless LAN for Projection” (page 88)

XJ-S35

CASIO YW-2

XJ-S35
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Document Camera (CASIO YC-400)
You can connect a CASIO YC-400 Document Camera to the Data Projector’s USB port 
and project the images of documents placed on the document stage of the YC-400.

For more information, see “Performing a Presentation Using the YC-400 Document Camera” 
on page 93.

XJ-S35

USB

YC-400
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Connecting a USB Device to the Data Projector

What happens when you connect a USB device to the Data Projector depends on the 
current configuration of the Data Projector’s plug-and-play setting. Plug-and-play is enabled 
under the Data Projector’s initial default settings. For more details about the plug-and-play 
setting, see “Setup Menu Contents” in the User’s Guide.

Turning On the Data Projector after Connecting a USB 
Device
Normally when you turn on the Data Projector without a USB device connected, the Data 
Projector will check the RGB terminal and then the VIDEO terminal for a signal. If it finds 
a signal, the Data Projector will select it automatically and project the signal contents.
If you turn the Data Projector on while a USB device is connected to its USB port, it will 
perform one of the following operations (depending on its current plug-and-play setting). 

When plug-and-play is enabled:

When plug-and-play is disabled:
Turning on the Data Projector with a USB device connected while plug-and-play is disabled 
will cause it to perform the same initial operation it performs when no device is connected. 
That is, it checks the RGB terminal and then the VIDEO terminal for an input signal. If it 
detects an input signal, the Data Projector will select it automatically and project the signal 
contents. In this case, however, either Viewer or Wireless will start up in the background, 
depending upon the type of USB device that is connected to the Data Projector.

When this type of 
device is connected:

The Data Projector does this automatically when turned on:

USB memory device Starts up Viewer (page 30) and projects the Viewer screen.

YW-2 Wireless Adapter Starts up Wireless (page 49) and projects the Wireless screen.

YC-400 Document 
Camera

Checks the RGB terminal and then the VIDEO terminal for an input 
signal. If it finds a signal, the Data Projector will select it automatically 
and project the signal contents. Note that the YC-400 Document Camera 
is not detected automatically.

Download from Www.Somanuals.com. All Manuals Search And Download.



10

Connecting to a USB Device while the Data Projector is 
On
If you connect a USB device to the Data Projector’s USB port while it is turned on, it will 
perform one of the following operations (depending on its current plug-and-play setting). 

When plug-and-play is enabled:

When plug-and-play is disabled:
In this case, the image that is currently being projected does not change. However, Viewer, 
Wireless, or the YC Camera Application will start up in the background, depending upon 
the type of USB device that is connected to the Data Projector.

Changing the Input Source while a USB Device is 
Connected
On the Data Projector’s remote controller, press the [INPUT] key to change the input 
source. Each time you press the [INPUT] key, the Data Projector will check the RGB 
terminal, VIDEO terminal, and USB port for an input signal. If it finds a signal, it will 
select it as the input source automatically and project its contents.

When this type of 
device is connected:

The Data Projector does this automatically:

USB memory device Starts up Viewer (page 30) and projects the Viewer screen. 

YW-2 Wireless Adapter Starts up Wireless (page 49) and projects the Wireless screen. 

YC-400 Document 
Camera

Starts up the YC Camera application (page 93) when the YC-400 
Document Camera is turned on and projects the YC Camera application 
screen. 
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Installing Data Projector Software

Use the procedures in this section to install the software that comes bundled with the 
Data Projector onto your computer.

Minimum System Requirements
The following describes minimum computer system requirements to run the bundled 
software.
• Operating System:Microsoft® Windows® XP or 2000 Professional
• Computer: IBM PC/AT or compatible that conforms to the following conditions.

• Windows® XP or 2000 Professional pre-installed
• PowerPoint 2000, 2002, or 2003 installed (to use EZ-Converter)
• CPU: Pentium III or higher
• USB port (Type A, USB1.1/2.0)
• Memory: 256 MB minimum or amount of memory recommended for operating system 

being run
• Hard Disk: At least 40 MB for installation or at least 60 MB when running
• Display: Full-color display with resolution of at least 800 × 600 that is supported by 

above operating systems and the computer being used.
• Pointing Device: Mouse or other equivalent device supported by above operating 

systems.
• Keyboard
• CD-ROM drive
• Other requirements of operating system being used

• Normal operation may not be possible under certain hardware configurations.
• Operation is not supported on a computer running Windows® NT, Me, 98SE, 98, 95, or 

3.1, or on a Macintosh or Mac OS computer.
• Operation on a computer upgraded to Windows® XP, 2000 Professional from another 

operating system is not supported.
• Operation on a computer running Windows® XP Professional x64 Edition is not 

supported.

When you want to do this: Install this software:

Convert files created with PowerPoint to image (JPEG) files and store 
them on a USB memory device

EZ-Converter

Send computer screen contents to the Data Projector over a wireless 
connection and project them

Wireless Connection
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To install software

1 Place the bundled CD-ROM into your computer’s CD-ROM drive.
This displays the dialog box shown below.

2 Select the check box of the software you want to install.

3 Click the [Install] button.
This will start installation.

4 Keep clicking the [Next] button on the dialog boxes that appear.
If your computer is running Windows XP and the dialog box shown below appears, click 
the [Continue Anyway] button.

If your computer is running Windows 2000 and the message “The software you are 
about to install does not contain a Microsoft digital signature.” appears, click the [Yes] 
button.

Download from Www.Somanuals.com. All Manuals Search And Download.



13

The dialog box shown below will appear after installation is complete.

5 Click the [Finish] button.
In response to the “Restart” confirmation dialog box, click the [Yes] button. This will 
restart your computer.
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Projecting Presentation Images from a USB 
Memory Device

This section explains how to perform the following operations.
Using the bundled EZ-Converter software to save a presentation file to a USB memory 
device

Connecting a USB memory device to the Data Projector and using Viewer to project image 
or movie data contained on the device

Important!
In order to perform the procedures in this section, you will first need to install the EZ-
Converter software from the bundled CD-ROM onto your computer. For more information, 
see “Installing Data Projector Software” (page 11).

The Data Projector supports connection of the following types of FAT/FAT32 format USB 
memory devices.

USB memory

USB Mass Storage Class compatible digital cameras

USB Mass Storage Class compatible hard disk drives (excluding types that require power 
supply from the USB port)

For details about supported USB memory devices (products whose operation has been 
confirmed), see the CASIO website at http://world.casio.com/projector/support/en/.

Supported USB Memory Devices
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The image data types listed below can be played back using the Data Projector’s Viewer.

JPEG format (jpg, jpeg, jpe) and BMP format (bmp) image files
• Playback of image files of approximately 6 Mbytes is supported.
• Progressive JPEG image files are not supported.
Movie files

For details about movie files supported for playback by the Data Projector and playback 
specifications, visit the CASIO website at: http://world.casio.com/projector/support/en.

EZ-Converter is software that runs on a Windows computer. You can use EZ-Converter to 
convert a file (ppt) created with Microsoft PowerPoint to presentation data that can be played 
back using the Data Projector’s Viewer feature.
Following conversion the presentation data can be stored on a USB memory device, which 
can then be connected to the Data Projector for the presentation.
Note that the conversion process may result in some differences between the original 
PowerPoint file and the resulting presentation data.

Presentation Data
The presentation data produced by EZ-Converter consists of presentation (plf) files and 
image (jpg) files. When you convert a PowerPoint file that includes 10 pages of data, EZ-
Converter will create 10 image (jpg) files and one presentation (plf) file that is linked to 
the image files. The presentation file will contain information about the sequence that the 
10 image files should be projected, along with other playback settings.

Supported Playback Data Types

Preparing a Presentation with EZ-Converter

Presentation Data

Image File Image File Image File Image File

Presentation File
• Image file information
• Presentation playback setting information

XXX-001.jpg XXX-002.jpg XXX-003.jpg XXX-004.jpg XXX-010.jpg

XXX.plf

Image File
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Main EZ-Converter Functions

PowerPoint File Conversion
• Conversion of PowerPoint files up to 500 pages in size
• Support for files created using PowerPoint 2000, 2002, 2003 for Windows
• Editing of converted presentation data with EZ-Converter

Important!
PowerPoint file animations are not supported. The image transition effect used is the 
one specified by the EZ-Converter presentation file.

Adding Image Files Directly to Presentation Files
In addition to converting PowerPoint pages to image files, you can also add individual 
image files directly to presentation data.
• You can add up to 500 JPEG format or BMP format image files directly to presentation 

data.

Starting Up and Exiting EZ-Converter

To start up EZ-Converter
On your computer’s Windows Start menu, select [Programs] - [CASIO] - [EZ-Converter]. 
This will cause the EZ-Converter window shown below to appear.

The above window indicates that there is no presentation data currently open. This is what 
we call an “empty” EZ-Converter window.

Important!
In order to start up EZ-Converter, PowerPoint 2000, 2002, or 2003 will need to be 
installed on the computer.

To exit EZ-Converter
On the [File] menu, select [Exit].
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Creating New Presentation Data
There are two ways that you can use EZ-Converter to create new presentation data: by 
converting a PowerPoint file (see below) or by inserting image files into the presentation 
data manually (page 19).

Creating Presentation Data by Converting a PowerPoint 
File
This procedure creates presentation data that includes all of the pages of the PowerPoint 
file. In order to perform this procedure, you will first need to prepare the PowerPoint file 
that you want to convert.

To create presentation data by converting a PowerPoint File

1 Start up EZ-Converter.
This will display the empty EZ-Converter window.
If EZ-Converter is already running on your computer and if there is already presentation 
data in the EZ-Converter window, click  to clear the data from the EZ-Converter 
window.

2 Configure presentation options as required.
For more information, see “Configuring the Option Setting” (page 20).

3 Either click  or select [Convert PowerPoint File] on the [File] menu.
This displays a dialog box for selecting PowerPoint files.
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4 Select the PowerPoint file you want to convert and then click [Open].
This starts conversion of the PowerPoint file, which is indicated by the appearance of a 
dialog box that shows the progress of the conversion.

After conversion is complete, the EZ-Converter widow will reappear with thumbnails of the 
converted images.

5 Add, delete, move, and otherwise edit the images as required.
For details, see “Editing Presentation Data” (page 21).

6 Configure presentation playback settings.
For more information, see “Configuring Presentation Data Playback Settings” (page 23).

7 To save the presentation data, click the [Save] button.
For details, see “Saving Presentation Data” (page 26).

Selected image number 
(from beginning)

Total number of files

Image file display area
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Note
Instead of steps 3 and 4 of the above procedure, you could also drop a single 
PowerPoint file into the EZ-Converter window.

Converting a PowerPoint file to presentation data will generate the following folder, 
image files and presentation file.
Example: When converting a 50-page PowerPoint file named “MeetingDocuments”

Creating Presentation Data by Inserting Image Files 
Manually
You can create new presentation data by dropping multiple image (jpg or bmp) files into 
the EZ-Converter window. In order to perform this procedure, you will first need to prepare 
the image files that you want to include in the presentation data.

To create presentation data by inserting image files manually

1 Start up EZ-Converter.
This will display the empty EZ-Converter window.
If EZ-Converter is already running on your computer and if there is already presentation 
data in the EZ-Converter window, click  to clear the data from the EZ-Converter 
window.

2 Use Windows Explorer to select all of the image files you want to include in the 
presentation data.

MeetingDocuments (Folder)
MeetingDocuments.plf Presentation file
MeetingDocuments001.jpg

Image files
MeetingDocuments002.jpg
MeetingDocuments003.jpg

:

MeetingDocuments050.jpg
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3 Drag the selected files into the EZ-Converter window.

This will insert the image files into the presentation data and display their thumbnails in 
the EZ-Converter window.

4 Add, delete, move, and otherwise edit the images as required.
For details, see “Editing Presentation Data” (page 21).

5 Configure presentation playback settings.
For more information, see “Configuring Presentation Data Playback Settings” (page 23).

6 To save the presentation data, click the [Save] button.
For details, see “Saving Presentation Data” (page 26).

Configuring the Option Setting
You can use option settings to specify the resolution of image files that are saved as EZ-
Converter presentation data.

Important!
Any changes you make to image settings using the procedure below will go into effect 
the next time you convert a PowerPoint file. Changed settings are not applied to 
presentation data that has already been created by converting PowerPoint files. Note 
that you cannot change the resolution of image data that is included in existing 
presentation data. 

To configure the option setting

1 On the [Tools] menu, select [Options].
This will display a dialog box for configuring the option setting.
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2 Configure the setting on the dialog box as described below.

3 After selecting the setting you want, click the [OK] button.
This will apply the setting and close the dialog box.

Editing Presentation Data
After you create presentation data by converting a PowerPoint file or by inserting image 
files manually, you can add, delete, and change the positions of image files as required.
Before performing the procedures here, you will need to display the EZ-Converter window 
that contains the presentation data that you want to edit. For details about how to do this, 
see “Creating New Presentation Data” (page 17) and “Opening Presentation Data” 
(page 28).

To add image files to presentation data

1 On the EZ-Converter window, click the thumbnail of the image that will come 
either before or after the image you are about to add.

2 Use Windows Explorer to select the image file you want to add to the 
presentation data.

You can select one or more image files.

3 Drag the selected files into the EZ-Converter window.
If you want the image file(s) to be inserted immediately following the image you selected 
in step 1, simply drop the image file(s) into the EZ-Converter window. If you want the 
image file(s) to be inserted in front of the selected image, hold down your computer’s 
[Ctrl] key as you drop the image file(s) into the window.
This will add the image file(s) and update the thumbnails in the EZ-Converter window.

When you want to do this when converting a PowerPoint file 
to presentation data:

Select this setting:

Save image files as high-quality JPEG files [High-quality]

Save image files as higher compression JPEG files [Normal-quality]
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Note
Instead of steps 2 and 3 of the above procedure, you could click  or you could 
select [Add Image to Presentation File] on the [Edit] menu. Then on the dialog box that 
appears, select one image file that you want to add to the presentation data. This will 
insert the image file into the presentation data immediately following the image you 
selected in step 1, above.

To delete an image file from presentation data

1 On the EZ-Converter window, click the thumbnail of the image you want to 
delete so it is selected.

2 Either click  or select [Delete Image from Presentation File] on the [Edit] 
menu.

This will delete the selected image.
In place of step 2, you could also press the [Delete] key on your computer keyboard.

Note
Deleting an image file from the presentation data does not delete the image data file 
from your computer’s hard disk.

To move an image file forward or back within presentation data

1 On the EZ-Converter window, click the thumbnail of the image you want to move 
so it is selected.

2 To move the selected image one position to the right (towards the end), click 
 or select [Move Image Back] on the [Edit] menu. To move the image one 

position to the left (towards the beginning), click  or select [Move Image 
Forward] on the [Edit] menu.

To undo an image operation
Select [Undo] on the [Edit] menu, or press [Ctrl] + [z] on your computer keyboard.
You can use the above operation to undo the last image file add, delete, or move 
operation you performed.
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Configuring Presentation Data Playback Settings
You can configure the following playback settings for playback of EZ-Converter presentation 
data with the Data Projector’s Viewer.
• Manual or auto image change
• Display time of each image file during auto image change
• Repeat play on/off
• Image transition effect

Note
The playback settings you configure are stored in the presentation (plf) file.

To configure presentation data playback settings

1 On the EZ-Converter window, display the presentation data whose playback 
settings you want to configure.

For details about how to do this, see “Creating New Presentation Data” (page 17) and 
“Opening Presentation Data” (page 28).

2 Click  or select [Presentation File Setup] on the [Tools] menu.
This displays a dialog box for configuring presentation file settings.
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3 Configure the following settings on the dialog box.

4 After configuring all the settings you want, click the [OK] button.

When you want to do this: Do this:

Change images manually during a 
presentation

Select [Manual] for [Display Interval].

Have images change automatically during a 
presentation

Select [Auto] for [Display Interval].

Specify the display interval during auto image 
change

This setting is available only while [Auto] 
is selected for [Display Interval].

Tap the down arrow button of the box under 
[Display Interval] and select an interval value 
(5 seconds, 10 seconds, 30 seconds, 
1 minute, and 5 minutes).

Have the presentation restart from the 
beginning after the final image file is reached

Select [On] under [Repeat].

Have the presentation stop after the final 
image is reached.

Select [Off] under [Repeat].

Turn off the image transition effect Select [Off] under [Image Transition Effect].

Turn on the image transition effect Select [On] under [Image Transition Effect].

Specify the effect to be applied when 
transitioning from one image file to the next

This setting is available only while [On] is 
selected for [Image Transition Effect].

Click the down arrow button of the box 
under [Image Transition Effect] and select an 
effect.

For details, see “Image Transition Effects” 
(page 25).
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Image Transition Effects
When “On” is selected for the “Image Transition Effect” setting on the “Presentation File 
Setup” dialog box, you can select a visual effect to be applied any time you transition 
from one image file to another. The following shows examples of each of the available 
effects.

Note
For information about performing a presentation using playback settings that are different 
from those that were stored with presentation data using EZ-converter, see “Configuring 
Viewer Setup Menu Settings” (page 41). 

Effect Name Example

Slide In - Left to Right

Slide In - Right to Left

Slide In - Top to Bottom

Slide In - Bottom to Top

Wipe - Left to Right

Wipe - Right to Left

Wipe - Top to Bottom

Wipe - Bottom to Top

Dissolve
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Saving Presentation Data
Use the procedures in this section to save presentation data to a USB memory device or 
to your computer’s hard disk.

To save presentation data to a new file

1 Perform the procedure under “Creating New Presentation Data” (page 17).

2 If you want to save the presentation data to a USB memory device, connect the 
device to your computer’s USB port.

For details about how to connect a USB device, see the user documentation that comes 
with your computer and the USB memory device you are using.

3 Click  or select [Save Presentation File] on the [File] menu.
This will display a dialog box for specifying a file name.

If you are saving presentation data produced by converting a PowerPoint file, the name 
of the PowerPoint file will be inserted in the dialog box automatically. In other cases, 
“New Presentation File” will be displayed in the dialog box.

4 Enter the file name you want and then click the [OK] button.
This will display a dialog box for specifying the location where you want to store the file.

5 Specify the location where you want to store the file and then click the [OK] 
button.

This will create a folder with the name you specified in step 4 and store the 
presentation data in the folder.
If there is already a folder with the same name as the one you specified at the location 
you specified, a confirmation message will appear asking if you want to replace the 
existing folder with the new one. If you do, click [Yes] on the dialog box. If you do not 
want to replace the existing folder with the new one, click [No]. This will return to the 
dialog box in step 3 of this procedure so you can enter a different name.
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Note
Performing this procedure will generate the presentation files shown below.

Example:When you input the folder name “Market Data 2006” for a 50-image 
presentation

To overwrite existing presentation data with newly edited data

1 Perform the procedure under “Editing Presentation Data” (page 21) or 
“Configuring Presentation Data Playback Settings” (page 23).

2 Click  or select [Save Presentation File] on the [File] menu.
This saves the existing presentation data with the edited data.

To save existing presentation data under a different name

1 On the EZ-Converter window, display the presentation data you want to save 
under a different name.

2 Click  or select [Save Presentation File] on the [File] menu.
This will display a dialog box for specifying a file name.

For the remainder of this procedure, perform the steps starting from step 4 under “To 
save presentation data to a new file” (page 26).

Market Data 2006 (Folder)
Market Data 2006.plf Presentation file
Market Data 2006 001.jpg

Image files
Market Data 2006 002.jpg
Market Data 2006 003.jpg

:

Market Data 2006 050.jpg
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Opening Presentation Data
Use the procedure below to open existing presentation data in order to edit it or to save it 
under a different name.

Note
To open presentation data, specify a presentation file (plf).

To open a presentation file

1 If the presentation data you want to open is stored on a USB memory device, 
connect the device to your computer’s USB port.

2 Click  or select [Open Presentation File] on the [File] menu.
This displays a dialog box for opening presentation files.

3 Select the presentation (plf) file you want to open and then click [Open].
This will open the presentation file and display the EZ-Converter window.

Viewing Help
To view EZ-Converter help, select [Help] on the [Help] menu.

Viewing Version Information
To view EZ-Converter version information, select [About EZ-Converter...] on the [Help] 
menu.
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This section provides detailed information about the EZ-Converter menu commands and about 
the buttons that appear on the EZ-Converter window.

EZ-Converter Menu and Button Reference

To do this:
Perform this menu 
operation:

Or click this 
button:

Convert a PowerPoint file to presentation data and display it 
in the EZ-Converter window

[File] - [Convert 
PowerPoint File]

Clear presentation data currently in the EZ-Converter window
[File] - [Clear 
Presentation File]

Open an existing presentation (plf) file and display its contents 
in the EZ-Converter window

[File] - [Open 
Presentation File]

Save the presentation data currently in the EZ-Converter 
window to an existing file, which overwrites the current 
contents of the existing file

[File] - [Save 
Presentation File(S)]

Save the presentation data currently in the EZ-Converter 
window to a new file

[File] - [Save 
Presentation File(T)]

 

Save the presentation data currently in the EZ-Converter 
window under a different name

[File] - [Save 
Presentation File(T)]

 

Exit EZ-Converter [File] - [Exit] –

Undo the last editing operation you performed on the EZ-
Converter window

[Edit] - [Undo] –

Add an image file to the presentation data currently in the 
EZ-Converter window

[Edit] - [Add Image 
to Presentation File]

Delete an image file from the presentation data currently in 
the EZ-Converter window

[Edit] - [Delete 
Image from 
Presentation File]

Move an image file in the presentation data currently in the 
EZ-Converter window one position to the left (towards the 
beginning)

[Edit] - [Move 
Image Back]

Move an image file in the presentation data currently in the 
EZ-Converter window one position to the right (towards the 
end)

[Edit] - [Move 
Image Forward]

Configure playback settings of the presentation data currently 
in the EZ-Converter window

[Tools] - 
[Presentation File 
Setup]

Specify the resolution and size of image files that are saved 
as EZ-Converter presentation data

[Tools] - [Options] –

Display EZ-Converter help [Help] - [Help] –

Display EZ-Converter version information
[Help] - [About EZ-
Converter...]

–
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Viewer is an application built into the Data Projector that lets you display image files and 
play back movie files that are stored on a USB memory device that is connected to the 
Data Projector. Viewer starts up automatically whenever you connect a supported USB 
memory device (see “Supported USB Memory Devices” on page 14) to the Data Projector’s 
USB port.

Note
All of the operations in this section are performed using the Data Projector’s remote 
controller keys or the Data Projector’s keys.

To connect a USB memory device to the Data Projector

1 Turn on the Data Projector.
Wait until the Data Projector’s POWER/STANDBY indicator is lit green.

2 Plug the USB memory device that contains the data you want to project with 
Viewer into the Data Projector’s USB port.

Once the Data Projector recognizes the USB memory device, Viewer will start up 
automatically and a menu of the files contained on the USB memory device will be 
projected in the projection area.

Playing a Presentation with Viewer
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Note
Viewer will not start up automatically if the Data Projector’s plug-and-play feature is 
turned off. In this case, you will need to press the [INPUT] key to switch the input 
source to the USB memory device. For more details about the plug-and-play setting, 
see “Setup Menu Contents” in the User’s Guide.

Only files of formats that are recognized by the Data Projector (jpg, jpeg, jpe, bmp, 
avi, mp4) appear in the file menu. Note that even if a file appears in the file menu, 
it does not mean that the file can be displayed or played back by the Data Projector.

The file menu displays USB memory device contents in the following sequence: 
folders, movie files, image files. For details about how to play back a movie file, see 
“Using Viewer to Play a Movie” (page 40).

File Menu Operations
When Viewer starts up, it initially projects a menu of files contained on the USB memory 
device. There are two different views for the file menu: a thumbnail view and a tree view.

Thumbnail View
This view shows thumbnails of the image files and movie files contained on the USB 
memory device. Folders are shown as icons.

Note
A question mark (?) in place of a thumbnail indicates an image file that cannot be 
displayed by Viewer for some reason.

Tree View
This view shows a Windows Explorer type tree representation of the folders, image files, 
and movie files on the USB memory device.

Thumbnail View Tree View
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To switch between the thumbnail view and the tree view

1 Press the [FUNC] key.
This displays the Viewer function menu shown below.

2 Use the [ ] key to move the highlighting to “Screen Format” and then press 
the [ENTER] key.

This toggles between the thumbnail view and the tree view

To scroll file menu pages
To scroll to the next menu page press the [ ] key. To scroll back to the previous page, 
press the [ ] key.

Note
Arrow indicators appear on right side of the file menu to indicate that there are more 
files above ( ) or below ( ) the current screen. Press the [ ] key to scroll down 
when  is indicated, or [ ] key when  is indicated.
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To select a file or a folder

Thumbnail View
Use the cursor keys to move the highlighting to the file or folder you want to select.

Tree View
Use the [ ] and [ ] cursor keys to move the highlighting to the file or folder you want to 
select.

Highlighting

Highlighting
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To open a folder

1 Use the cursor keys to select the file you want to open.

2 Press the [ENTER] key.
This opens the selected folder and displays a menu of its contents.
With the tree view, you could also press the [ ] key instead of the [ENTER] key.

To close the current folder and move up to the next level

Thumbnail View
Press the [ESC] key.

Tree View
Press the [ ] key. This will collapse the folder where the highlighting is currently located 
and move the highlighting to the next higher level.

To select a file menu item and display its image

1 Use the cursor keys to select the file whose image you want to display.

2 Press the [ENTER] key.
This will display a full-size version of the image that fills the projection area.

3 To return to the file menu, press the [ESC] key.

Note
If the selected file is too large to fit within the projection area, the message “Cannot 
display an image file.” will appear.

For information about operations you can perform while the image of a file is being 
projected, see “Operations during Image File Content Projection” (page 38).

To start a slideshow from a particular image file

1 Use the cursor keys to select the file whose image from which you want to 
start the slideshow.

2 Press the [ ] key.
This will display a full-size version of the image that fills the projection area. Now the 
Data Projector will advance to the next image automatically at a regular interval (default: 
5 seconds).
If “Manual” is selected for the “Image Switching” setting, the image will not change 
automatically. In this case, press the [ ] key to advance to the next image.

3 To stop the slideshow and return to the file menu, press the [ESC] key.
The slideshow will also stop automatically and the file menu will appear when the final 
image file in the folder where the file you selected in step 1 is reached.
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Note
A slideshow displays the image files (jpg or bmp) that are included in the same 
folder as the image file you select in step 1 of the above procedure. All other files 
are ignored.

For details about operations you can perform during a slideshow, see “Operations 
during a Slideshow” (page 39).

For information about how you can specify the interval between images, image 
transition effects, and other playback settings, see “Configuring Viewer Setup Menu 
Settings” (page 41).

A slideshow that uses presentation data created with EZ-Converter will be played 
back in accordance with the playback settings included in the presentation data. For 
details, see “Configuring Presentation Data Playback Settings” (page 23).

To move the highlighting to the previously projected image file

1 While the thumbnail view or tree view is being projected, press the [FUNC] key.
This will display the Viewer function menu.

2 Use the [ ] key to move the highlighting to “Return to previously displayed 
image.” and then press the [ENTER] key.

This returns to the image file that was projected immediately before the last projected 
file.

Note
This function comes in handy in the following cases.

To return the highlighting to the last projected image file after projecting a movie file.

To return the highlighting to the image where a slideshow was paused in order to 
project a movie file.
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Using the Presentation Menu
The folder that contains the presentation file created using the EZ-Converter software (page 
15) that comes bundled with the Data Projector is called a “presentation folder”.
Presentation folders appear along with other folders on the Viewer file menu, and they are 
indistinguishable from other folders. Because of this, Viewer also provides a “presentation 
menu” that makes it easy to find all of the presentation folders that are included on a 
USB memory device.

To view the presentation menu

1 While the Viewer file menu is shown, press the [FUNC] key.
This displays the Viewer function menu shown below.

2 Check to make sure that “View Presentation List” is selected and then press the 
[ENTER] key.

This displays a presentation menu like the one shown below.

Thumbnail of first image
file in presentation

Presentation properties

Presentation path

Presentation file menu
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To perform a slideshow by running a presentation file

1 Use the [ ] and [ ] keys to move the highlighting to the presentation file you 
want to run.

2 Press the [ENTER] key or the [ ] key.
This will start the currently selected presentation file.
The image file sequence, display time for each image, and image transition effect will all 
be in accordance with the settings stored in the presentation file. For more information, 
see “Configuring Presentation Data Playback Settings” on page 23.

3 To stop the slideshow, press the [ESC] key.

Note
The file menu (not the presentation menu) will reappear after the slideshow stops 
when you press the [ESC] key or after it stops automatically.

For details about operations you can perform during a slideshow, see “Operations 
during a Slideshow” (page 39).

To return to the file menu from the presentation menu
Press the [ESC] key.
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Operations during Image File Content Projection

To scroll between image files
Use the [ ] and [ ] keys.

Note
Scrolling to a file that is too large to fit within the projection area will cause the 
message “Cannot display an image file.” to appear.

To rotate an image
Use the [ ] and [ ] keys.

Note
You can also rotate an image by pressing the [FUNC] key to display the Viewer 
function menu. Move the highlighting to “Rotate Right” or “Rotate Left” and then press 
the [ENTER] key.

To start a slideshow from the currently displayed image file content
Press the [ ] key.

Note
You can also start a slideshow from the currently displayed image file content by 
pressing the [FUNC] key to display the Viewer function menu. Move the highlighting to 
“Start Slideshow” and then press the [ENTER] key.

To return to the file menu from image file content
Press the [ESC] key.

To do this: Press this key:

Display the content of the next image file [ ]

Display the content of the previous image file [ ]

To do this: Press this key:

Rotate the image 90 degrees right [ ]

Rotate the image 90 degrees left [ ]
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Operations during a Slideshow

To pause a slideshow while auto image change is turned on
Press the [ ] key.

To unpause a slideshow while auto image change is turned on
Press the [ ] key.

To scroll between image files during a slideshow
Use the cursor keys.

Note
After scrolling to an image file, the slideshow will scroll to the next image file 
automatically after the preset time interval if “Auto” is selected for the “Image Switching” 
setting. Note, however, that this is not true while the slideshow is paused.

To stop a slideshow and return to the file menu
Press the [ESC] key.

To do this: Press this key:

Scroll to the content of the next image file [ ]

Scroll to the content of the previous image file [ ]
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Slideshow Start Error
The error message shown below may appear when you attempt to start a slideshow using 
one of the procedures under “To start a slideshow from a particular image file” (page 34), 
“To perform a slideshow by running a presentation file” (page 37), or “To start a slideshow 
from the currently displayed image file content” (page 38).

If this happens, use EZ-Converter to create a new presentation file and store it on the 
USB memory device. Next, use the new presentation file to run the slideshow.

Using Viewer to Play a Movie
This section explains procedures you can use to play a movie using Viewer.

To play a movie file

1 On the file menu, select the movie file you want to play.
For information about how to select a particular file on the file menu, see “To select a 
file or a folder” (page 33).

2 Press the [ENTER] key.
This will start playback of the selected movie file.

3 To stop movie playback and return to the file menu, press the [ESC] key.

Note
Pressing the [ENTER] key while a file whose playback is not supported by the Data 
Projector is selected will cause the error message “This movie file cannot be played 
back.” to appear. For more information, see “Supported Playback Data Types” (page 15).

There is a problem with the slideshow setup file. Cannot start the slideshow.
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Configuring Viewer Setup Menu Settings
You can use the Viewer Setup Menu to configure viewer display settings and to perform a 
presentation using playback settings that are different from those that were stored with 
presentation data using EZ-Converter. 

Note
When you perform a slideshow by running a presentation file created with EZ-
Converter, the slideshow settings on the Viewer setup menu (Image Switching, 
Slideshow Display Interval, Slideshow Transition Effect, and Slideshow Repeat) are 
changed automatically to the playback settings (page 23) saved in the presentation file 
you are running.

In order to modify slideshow settings for which “Auto” was selected for the 
presentation file’s “Image Switching” setting when the file was created with EZ-
Converter, you need to pause the slideshow, open the menu, and then change the 
settings as required. 

To configure Viewer setup menu settings

1 Press the [MENU] key to display the setup menu.

2 Press the [ ] key to move the highlighting to “USB” and then press the 
[ENTER] key.

3 Press the [ ] key once to move the highlighting to “Setup” and then press the 
[ENTER] key.

This will display the Viewer setup menu.

4 Use [ ] and [ ] to select the menu item whose setting you want to change.
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5 What you should do next depends on whether or not [ENTER] is displayed at 
the far right of the setting you are configuring (the one that is highlighted).

If [ENTER] is displayed:
a. Press the [ENTER] key.
b. On the submenu that appears, use [ ] and [ ] to move the highlighting to the setting 

you want to select.
Example: The following is the submenu that appears when “Display Sequence Setup” is 

selected in step 2, above.

c. Press the [ENTER] key.
This will return to the Viewer setup menu.

If [ENTER] is not displayed:

Press the [ ] or [ ] key to select the setting you want (so its button is ).

6 Repeat steps 4 and 5 to configure other settings, if you want.

7 After all the settings are the way you want, press the [MENU] key to exit the 
Viewer setup menu.

To restore all settings on the Viewer setup menu to their initial factory 
defaults

1 Press the [MENU] key to display the setup menu.

2 Press the [ ] key to move the highlighting to “USB” and then press the 
[ENTER] key.

3 Press the [ ] key once to move the highlighting to “Setup” and then press the 
[ENTER] key.

This will display the Viewer setup menu.

4 Press the [ ] key to move the highlighting to “Initialize Viewer Setup” and then 
press the [ENTER] key.

This displays the dialog box shown below.

5 Use the [ ] key to select “Yes”.
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6 To restore all the settings to their initial defaults, press the [ENTER] key.
To exit the operation without doing anything, press [ESC] instead of [ENTER].

7 To exit the Viewer setup menu, press the [ESC] key.

Viewer Setup Menu Contents
This section provides detailed explanations of all of the items included on the Viewer setup 
menu. 

Setting Name Description

Image Zoom In the case of image sizes other than XGA, specifies whether or not to 
enlarge or reduce (zoom) images to fit the projection area.
Zoom:

Turns on image zooming.
No Zoom:

Turns off image zooming.

Display Sequence 
Setup

Specifies the sequence of images in the file menu or presentation menu.
File Names (Ascending):

Displays files in file name ascending order.
File Names (Descending):

Displays files in file name descending order.

Time (New-to-Old):
Displays files by the time they were last modified, from the newest to the 
oldest.

Time (Old-to-New):
Displays files by the time they were last modified, from the oldest to the 
newest.

Startup Mode Specifies whether the initial view when Viewer is started up is the thumbnail 
view or tree view. See “File Menu Operations” (page 31) for more information.

Thumbnails:
Specifies thumbnail view.

Tree:
Specifies tree view.

Image Switching Specifies the slideshow image change method.

Manual:
Specifies manual image change.

Auto:
Specifies auto image change.

Slideshow Display 
Interval

Specifies how long each image will remain displayed during a slideshow.
5 seconds, 10 seconds, 30 seconds, 1 minute, 5 minutes

Slideshow 
Transition Effect

Specifies the image transition effect to be used during a slideshow. For more 
information see “Image Transition Effects” (page 25).
Off, Slide In - Left to Right, Slide In - Right to Left, Slide In - Top to 
Bottom, Slide In - Bottom to Top, Wipe - Left to Right, Wipe - Right to 
Left, Wipe - Top to Bottom, Wipe - Bottom to Top, Dissolve
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Slideshow Repeat Specifies whether or not slideshows and movie file playback should repeat 
when the end it reached.

On:
Slideshows and movie playback are repeated.

Off:
Slideshows and movie playback are not repeated.

Movie Display Specifies the display size during movie playback.

Zoom:
Enlarges to the size of the projection area.

No Zoom:
Specifies the original size of the movie file.

Initialize Viewer 
Setup

Returns all Viewer setting menu items to their initial default settings. For 
details, see “To restore all settings on the Viewer setup menu to their initial 
factory defaults” on page 42.

Setting Name Description
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Viewer Error Messages
Message Cause Required Action

There is a problem 
with the slideshow 
setup file. Cannot 
start the slideshow.

There is some problem 
with the presentation file 
created with EZ-Converter.

Use EZ-Converter to regenerate the entire 
set of presentation data (presentation file 
and image files) and save the new data to 
the USB memory device.

Folder does not 
contain any image 
files.

There is no displayable 
folder, image file, or 
movie file in the folder 
you are trying to access 
with Viewer.

Use EZ-Converter to generate 
presentation data and save it to the USB 
memory device.
Copy image files or movie files from your 
computer to the folder on the USB 
memory device.

Cannot display an 
image file.

The image file cannot be 
displayed because it is 
too large to display within 
the projection area or 
because there is 
something wrong with it.

Make sure the image files on the USB 
memory device are no larger than 6 Mbytes.

Important!
Progressive JPEG image files are not 
supported.

Could not find an 
image file.

One or more image files 
that were saved as 
presentation data cannot 
be found.

Use EZ-Converter to regenerate the entire 
set of presentation data (presentation file 
and image files) and save the new data to 
the USB memory device.

This movie file 
cannot be played 
back.

The file you are trying to 
play back is an 
unsupported format or 
there is something wrong 
with it.

Convert the unsupported file to a file 
format that is supported and copy it to 
the USB memory device.
Copy a movie file that is a format 
supported by Viewer to the USB memory 
device.
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Some folders and/or files are not displayed in the file menu
• All the folders and/or files contained in a folder will not be displayed if there are more 

than 999 folders and/or files inside the folder. If this happens, reduce the number of 
folders and/or files in the folder. 

• Viewer supports up to 10 folder nesting levels on a USB memory device. Anything past 
the 10th nested folder is not displayed by Viewer. 

How can I get images to appear more quickly?
When you select a BMP image or a large image file recorded with a digital camera on 
the Viewer’s image menu, it takes considerable time before the image appears. To ensure 
that images appear quickly during your presentation, use EZ-Converter to convert the 
images to presentation data. This will cause images to be converted to JPEG images, 
which appear on the display more quickly. 

I am having a hard time getting the results I want when playing a 
slideshow.
• Use EZ-Converter to convert the images you want to use in the slideshow to 

presentation data. 
• In order to start a slideshow by highlighting an image file in a folder that is not a 

presentation data folder, you first need to use the Viewer Setup menu to configure 
slideshow settings (Slideshow Display Interval, Slideshow Transition Effect, Image 
Switching, Slideshow Repeat).

Viewer Troubleshooting
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Performing a Presentation Using a Wireless LAN
(Projecting Computer Screen Contents Over a Wireless LAN)

This section explains how to establish a wireless LAN connection between the Data Projector 
and a computer and project the computer’s screen contents over the wireless LAN.

CASIO YW-2S wireless adapters are required in order to establish a wireless LAN connection 
between a computer and the Data Projector. The YW-2S package includes two YW-2 USB 
type wireless adapters, one for the Data Projector and one for the computer.

Important!
Note that use of any other wireless adapter besides the YW-2 is not supported.

Use of the stickers that come with the YW-2 Wireless LAN adapter is not necessary 
when you connect a YW-2 to the XJ-S35 Data Projector.  

Computer Requirements
In addition to the “Minimum System Requirements” (page 11), the computer must also 
conform to any one of the following in order to establish a wireless LAN connection with 
the Data Projector.
a. YW-2 wireless adapter plugged into a USB port
b. Built-in wireless LAN function conforming to IEEE 802.11b standard
c. Add-on wireless LAN function (other than YW-2) conforming to IEEE 802.11b standard
All of the explanations in this manual are based on a computer that conforms to “a. YW-2 
wireless adapter plugged into a USB port”.

Important!
There is no guarantee that all computers conforming to one of the above conditions will 
be able to establish a wireless LAN connection with the Data Projector.

Supported Wireless LAN Devices
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Preparing the Computer for Wireless LAN Connection 
with the Data Projector
Before attempting the operations in this section, be sure to prepare the computer by 
following the steps below.

If you are using the YW-2 wireless adapter

1 On your computer, install “Wireless Connection” from the CD-ROM that comes 
bundled with the Data Projector.

For more information, see “Installing Data Projector Software” (page 11).

2 Connect the YW-2 wireless adapter to your computer’s USB port.

If you are using another wireless LAN adapter (including a computer’s built-
in wireless LAN)

1 Make sure that the wireless LAN of the computer (either a built-in wireless LAN 
or add-on wireless LAN) conforms to the IEEE 802.11b standard.

2 On your computer, install “Wireless Connection” from the CD-ROM that comes 
bundled with the Data Projector.

For more information, see “Installing Data Projector Software” (page 11).
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This section explains the basic terminology for the Data Projector’s wireless LAN.

Wireless Function and Wireless Connection Software
The Data Projector has a built-in function named “Wireless”, which you can use to 
configure Data Projector settings for wireless LAN connection with a computer, and perform 
Data Projector operations (such as displaying connection information, switching computers 
when there are multiple computers connected over a wireless LAN, etc.) after a connection 
is established. Wireless starts up automatically whenever you connect a CASIO YW-2 
wireless adapter to the Data Projector’s USB port.
Wireless Connection is software that runs on a Windows computer. It lets you configure 
computer settings for wireless LAN connection with the Data Projector, and perform 
computer operations (such as sending computer screen contents to the Data Projector) 
after a connection is established. You can also use Wireless Connection to display the 
“Web Setup” page for configuring advanced wireless LAN connection settings (see 
“Advanced Wireless LAN Connection Settings” on page 62).

About Data Projection Connection Profiles
A setup for a wireless LAN connection is called a “connection profile”. There are two types 
of connection profiles: “simple connections” and “manual connections”. The Data Projector 
comes with a following connection profiles built in. You can use the Data Projector’s 
Wireless function to switch the current connection profile. Since Wireless Connection is 
already equipped with the same Simple Connection 1, 2, and 3 profiles as the Wireless 
function, all you need do is select the same profiles with Wireless and Wireless connection 
to establish a wireless LAN connection. Note, however, that this is true only when a 
CASIO YW-2 wireless adapter is connected to the computer.

Note
The Data Projector has six connection profiles: three simple connections and three 
manual connections. These numbers are fixed and cannot be changed.

About the Data Projector’s Wireless LAN

Connection 
Profile

Initial Profile 
Name

Description

Simple 
Connection 1 –

These profiles mainly are for establishing a simple 
connection between the Data Projector and a single 
computer with a CASIO YW-2 wireless adapter. The 
settings of these profiles are fixed and cannot be changed.

Simple 
Connection 2 –
Simple 
Connection 3 –
Manual 
Connection 1

Sample 1 These profiles mainly are for wireless LAN connection of 
multiple computers to the Data Projector at the same time. 
The initial default setup of each profile can be used to 
configure a wireless LAN connection, or you can modify the 
settings of a profile to improve security and save the profile 
under a new name.

Manual 
Connection 2

Sample 2

Manual 
Connection 3

Sample 3

Download from Www.Somanuals.com. All Manuals Search And Download.



50

This section explains the basic procedures for configuring settings for a wireless LAN 
connection between the Data Projector and a computer.

This section includes the basics for establishing a wireless LAN connection between the 
Data Projector and a single computer, or between the Data Projector and multiple 
computers. For details about increasing security and settings required for connection to a 
wireless LAN access point, see “Advanced Wireless LAN Connection Settings” (page 62).
For details about projection operations after establishing a connection, see “Using Wireless 
LAN for Projection” (page 88).

Important!
The procedure below assumes that the Data Projector’s plug-and-play feature is turned 
on (which is the initial default setting). If you have turned off plug-and-play, turn it 
back on before performing the procedure below. For more details about the plug-and-
play setting, see “Setup Menu Contents” in the User’s Guide.

The operations described here assume that the CASIO YW-2 wireless LAN adapter is 
connected to the computer. In the case of a computer equipped with another 
manufacturer’s wireless LAN adapter or a built-in wireless LAN adapter, configure 
settings in accordance with the user documentation that comes with the adapter you 
are using.

Wireless LAN Connection Basics
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Establishing a Wireless LAN Connection with a Single 
Computer Using a Simple Connection

To establish a wireless LAN connection between a single computer and the 
Data Projector

Note
The following explains the simplest type of connection. It shows how to use the Data 
Projector’s built-in connection profile named “Simple Connection 1” to establish a 
wireless LAN connection with a single computer.

1 Turn on the Data Projector.
Wait until the Data Projector’s POWER/STANDBY indicator is lit green.

2 Connect the CASIO YW-2 wireless adapter to the Data Projector’s USB port.
You could also turn on the Data Projector with the wireless adapter already connected to 
the USB port.
The Data Projector will detect the wireless adapter and start up its Wireless function 
automatically. The message shown below will appear in the projection area.

3 Turn on your computer and start up Windows.

4 If your computer is already connected to a wireless network, disable the 
connection.

On the Windows Control Panel, click “Network Connections” (“Network and Dial-up 
Connection” in the case of Windows 2000). If “Wireless Network Connection” is displayed 
on the window that appears, right-click the icon and then click “Disable” on the dialog 
box that appears.

Check to make sure that “Simple Connection 1” 
is shown.
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5 Connect the YW-2 wireless adapter to your computer’s USB port.
The first time you connect a wireless adapter, a hardware installation warning message 
may appear on your computer screen. If it does, click the [Continue Anyway] button.
Connecting the wireless adapter will cause Wireless Connection to start up automatically 
and display the dialog box shown below. If this does not happen, go to the Windows 
[Start] menu and select [Programs] - [CASIO] - [Wireless Connection].

When the computer finds the Data Projector, communication will start between them.
This will establish a wireless LAN connection between the computer and Data Projector 
automatically and cause the Wireless Connection window shown below to appear on the 
computer screen.

The contents of the computer screen will be projected automatically at this time.
For details about Wireless Connection window operations and Data Projector remote 
controller operations you can perform after establishing a connection, see “Using Wireless 
LAN for Projection” (page 88).

Note
A message like “Wireless Connection.exe is trying to access the Internet” may appear 
when the computer you are using has security software installed. If this happens, select 
“Always allow (access)” on the dialog box. 

6 To terminate Wireless Connection operation, click the [×] button in the upper 
right corner of the Wireless Connection window or select [Exit] on the 
[Connection] menu.

This will close the Wireless Connection window and terminate the connection between the 
computer and Data Projector. At this time, the projected image will return to the 
message in step 2 of this procedure.
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Important!
The above procedure will not establish a wireless LAN connection if the connection 
profile of the Data Projector is different from the profile used the first time a connection 
was established between the computer and Data Projector (Simple Connection 1 in this 
example). In this case, press the Data Projector’s remote controller [ ] key to display 
the “Connection Profile” menu and then select the original connection profile (Simple 
Connection 1 for this example). For details, see “To switch the Data Projector 
connection profile” (page 66).

Establishing a Wireless LAN Connection with Multiple 
Computers Using a Manual Connection
This section explains how to connect up to four computers to a single Data Projector (over 
a wireless LAN access point) at the same time. The following are the general steps that 
are required.

1 Prepare for wireless LAN connection of the Data Projector and the computers (below).

2 Create connection profiles for the computers (page 54).

3 Use the Manual Connection profile to establish a wireless LAN connection between the 
first computer and the Data Projector (page 56).

4 Use the Manual Connection profile to establish a wireless LAN connection between the 
other computers and the Data Projector (page 60).

1111To prepare for wireless LAN connection of the Data Projector and the 
computers

1 Install Wireless Connection on all of the computers. 

2 Connect YW-2 wireless adapters to the USB port of each of the computers.
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2222To create connection profiles for the computers

1 Start up Wireless Connection on the first computer. 
Wireless Connection should start up automatically when you connect the YW-2 wireless 
adapter to the computer’s USB port. If it does not, go to the Windows [Start] menu and 
select [Programs] - [CASIO] - [Wireless Connection]. 

2 On the Wireless Connection window of the first computer, select “Switch 
Connection Profile” on the “Connection” menu.

This will display a dialog box for switching the connection profile.

3 Click the [New] button.
This will display a dialog box for configuring a new manual connection profile.
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4 Configure the settings on the dialog box.
In this example, we will use the following settings.

For details about each of the settings on the dialog box, see “Manual Connection Setting 
Reference” (page 77).

5 After configuring all of the settings you want, click the [Register] button.
This will register your settings as a new connection profile (named “Manual Connection 
Test” here) and return to the connection profile switching dialog box in step 1. The newly 
created profile (Manual Connection Test) will be selected on the dialog box.

6 Repeat steps 1 through 5 for all of the other computers.
For the settings in step 4, simply change the IP address as shown below.
Computer 2: 192.168.100.10
Computer 3: 192.168.100.11
Computer 4: 192.168.100.12

Dialog Box Item Setting

Profile Name Manual Connection Test

SSID CASIO_DPJ

Access Mode Ad Hoc

Security Setup WEP

WEP Key Format ASCII/128bit

WEP Key/WPA/WPA2 Pass Phrase 1234567890abc

DHCP Off

IP Address 192.168.100.1

Subnet Mask 255.255.255.0

Default Gateway 0.0.0.0

Channel Auto 
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3333To use the Manual Connection profile to establish a wireless LAN 
connection between the first computer and the Data Projector

Note
Perform the following steps while the connection profile dialog box is on the display at 
the end of the procedure under “2 To create connection profiles for the computers” 
(page 54). 

1 Use the Simple Connection profile to establish a wireless LAN connection 
between the first computer and the Data Projector. 

See “Establishing a Wireless LAN Connection with a Single Computer Using a Simple 
Connection” on page 51 for more information. 
If a Simple Connection is already established between the first computer and the Data 
Projector, proceed to step 2. 

2 On the Wireless Connection window of the first computer, select “Switch 
Connection Profile” on the “Connection” menu.

This will display a dialog box for switching the connection profile.

3 Click the “Profile Name” down arrow button and then select “Manual Connection 
Test” from the menu that appears.

4 Click the [Send Settings] button.
This will display a dialog box for sending the setup.

5 Select “Manual Connection 1” for “Send Destination”, and then click the [OK] 
button.

This will cause the dialog box shown below to appear.

6 Click the [OK] button.
This will return to the dialog box for switching the connection profile.
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7 Click the [Close] button.
This will cause the dialog box shown below to appear.

8 On the Data Projector’s remote controller, press the [ ] key.
This will cause the connection profile menu to appear in the projection area.

9 Use the [ ] key to move the highlighting to “Manual Connection 1” and then 
press the [ENTER] key.

This will display the dialog box shown below.

10 Press the [ ] key to move the highlighting to “Yes” and then press the [ENTER] 
key.

This will cause the message shown below to appear in the projection area.

11 Check the message that appears on the computer screen.
When the computer finds the Data Projector, the display will change to a dialog box like 
the one shown below for selecting the connected device.

Check to make sure that “Manual Connection 1 
(Manual Connection Test)” is shown.

If there are other XJ-S35 Data Projectors with 
wireless adapters connected in the area, all 
of them that are detected will appear in the 
list.
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12 Move the highlighting to the XJ-S35 Data Projector to which you want to 
connect and then click the [OK] button.

Normally, there will be only one Data Projector in the list (the one whose settings you 
are configuring) so you should be able to click the [OK] button without doing anything 
else.
The computer will connect with the Data Projector and the above dialog box will close. 
Confirm that the “Connection Profile” setting for the connected device information on the 
Wireless Connection window shows “Manual Connection 1 (Manual Connection Test)”.

13 On the Wireless Connection window, select “Options” on the “Tools” menu.
This will display a dialog box for configuring the option setting.

14 In the “User Name” box, enter the user name (the name you want to appear in 
the projection area when projecting the screen contents of this computer) for the 
computer whose settings you are configuring.

You can input up to 12 characters for the user name.

User name

Projection area position buttons 
(Used in step 16).
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15 Click the [OK] button.

16 On the Wireless Connection window, click one of the projection area position 
buttons and then click the  button.

This will cause the contents of the computer screen to be projected so they fill the 
entire projection area. At this time the user name will appear in the upper left corner of 
the projection area.

17 On the Data Projector’s remote controller, press the [ ] key.
This will display a user menu like the one shown below. You can use the user menu 
when multiple computers are connected to the Data Projector to select which computer’s 
screen image will fill the entire projection area. The location of each computer’s image 
on the user menu screen will be in accordance with the projection area position button 
you selected for the computer.

User Names
“Not connected” appears in 
place of the user name for all 
positions that do not have a 
computer assigned using the 
projection area position buttons.
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4444To use the Manual Connection profile to establish a wireless LAN 
connection between the other computers and the Data Projector

Note
Perform the following steps after finishing the procedures under “2 To create connection 
profiles for the computers” (page 54) and “3 To use the Manual Connection profile to 
establish a wireless LAN connection between the first computer and the Data Projector” 
(page 56).

1 On the connection profile switching dialog box for each of the other computers, 
click the “Profile Name” down arrow button and then select “Manual Connection 
Test” from the menu that appears.

2 Click the [Close] button.
This will cause the dialog box shown below to appear. 

When the computer finds the Data Projector, the display will change to a dialog box like 
the one shown below for selecting the connected device. 

3 Move the highlighting to the XJ-S35 Data Projector to which you want to 
connect and then click the [OK] button. 

Normally, there will be only one Data Projector in the list (the one whose settings you 
are configuring) so you should be able to click the [OK] button without doing anything 
else. 
The computer will connect with the Data Projector and the above dialog box will close. 
Confirm that the “Connection Profile” setting for the connected device information on the 
Wireless Connection window shows “Manual Connection 1 (Manual Connection Test)”. 

Download from Www.Somanuals.com. All Manuals Search And Download.



61

4 On the Wireless Connection window, select “Options” on the “Tools” menu.
This will display a dialog box for configuring the option setting.

5 In the “User Name” box, enter the user name (the name you want to appear in 
the projection area when projecting the screen contents of this computer) for the 
computer whose settings you are configuring

You can input up to 12 characters for the user name.

6 Click the [OK] button.

7 On the Wireless Connection window, click one of the projection area position 
buttons and then click the  button.

A projection area that is available for selection is indicated by , while an area that is 
already selected is indicated by . You can select any one of the areas that has  
indicated.
The screen contents of the second computer will appear in the area of the projection 
area position button you select here.

8 Repeat steps 1 through 7 for the third and fourth computers.
The screen contents of the third and fourth computer will appear in the area of the 
projection area position buttons you select here.

9 To use the entire projection area to display a particular computer’s screen 
image, use the cursor keys to move the highlighting to the desired image and 
then press the [ENTER] key (or [ ] key).

This will cause the contents of the highlighted computer screen to fill the entire projection 
area.
For details about Wireless Connection window operations and Data Projector remote 
controller operations you can perform after establishing a connection, see “Using Wireless 
LAN for Projection” (page 88).
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This section explains how to configure advanced settings for a wireless LAN connection 
between the Data Projector and a computer.

All of the operations in this section assume that you have already configured the settings 
under “Wireless LAN Connection Basics” (page 50).

For details about projection operations after establishing a connection, see “Using Wireless 
LAN for Projection” (page 88).

Web Setup
In order to modify the settings of a Data Projector manual setup profile and to configure 
advanced settings of other Data Projector settings, you need first to display a special web 
browser page named “Web Setup” on you computer screen. To display Web Setup, use a 
web browser running on a computer that is connected to the Data Projector over a 
wireless LAN.

To display and log into the Web Setup page

1 On the Wireless Connection window of the computer that is connected to the 
Data Projector over a wireless LAN, click the  button.

This will start up the computer’s default browser and display an initial page like the one 
shown below.

Advanced Wireless LAN Connection Settings
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2 Enter the password and then click the [OK] button.
The initial default password is “casio”.
The above step will display the Web Setup top page like the one shown below.

Note
For security reasons, be sure to change the password to something else as soon as 
possible. For details, see “To change the Web Setup login password” (page 63).

You also can display the Web Setup page by selecting “Options” on the Wireless 
Connection window’s “Tools” window. On the option dialog box that appears, click the 
[Web Setup] button.

To log out of Web setup
Click “Logout” in the upper right corner of the page.

Note
You also will be logged out automatically if you do not perform any Web Setup page 
operation for about five minutes.

To change the Web Setup login password

1 On the initial Web Setup page, click the [Change Password] button.
This will display the change password page.

2 In the “Current Password” box, enter the current password (“casio” if you have 
not yet changed the initial default password) and then enter the new password 
into the “New Password” box.

A password must have at least four single-byte characters and it can be up to 16 
characters long.

3 Input the new password again into the lower “New Password” box.
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4 Click the [Change] button.
If you input all of the required information correctly, your password will be changed and 
the Web Setup top page will reappear.

Enabling and Disabling Web Setup
This section explains how you can disable the Web Setup page so it is not displayed 
when you perform Data Projector operations. You can disable the Web Setup page when 
you want to restrict access to Web Setup while there are multiple computers connected to 
the Data Projector.

To enable and disable Web Setup

1 While Wireless is shown in the projection area, press the [MENU] key on the 
Data Projector’s remote controller.

This will display the setup menu.

2 Press the [ ] key to move the highlighting to “USB” and then press the 
[ENTER] key.

3 Press the [ ] key once to move the highlighting to “Setup” and then press the 
[ENTER] key.

This will display the Wireless setup menu.

4 Press the [ ] key to move the highlighting to “Web Setup”.

5 Use [ ] and [ ] to select “Enable” or “Disable”.
Selecting “Disable” will make it impossible to access the Web Setup page from any 
computer.

6 To exit the Wireless setup menu, press the [ESC] key.
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Switching the Data Projector Connection Profile
The Data Projector uses one of its six connection profiles to connect to a computer over 
a wireless LAN. You can use the following procedure to switch the connection profile as 
required.

To view the Data Projector’s current connection profile information

1 While Wireless is shown in the projection area, press the [FUNC] key on the 
Data Projector’s remote controller.

This will display the Wireless function menu.

The contents of the Wireless function menu will differ according to the operational status 
of the Data Projector when you press the [FUNC] key. The above example shows the 
menu when the [FUNC] key is pressed while “Standing by for connection...” is displayed 
in the projection area.

2 Check to make sure that “View Connection Info” is selected and then press the 
[ENTER] key.

This will display the connection information window, which shows the currently selected 
profile and the settings of the profile.

3 To close the connection information window, press the [ESC] key of the Data 
Projector’s remote controller.

Note
You can also view the Data Projector’s current connection profile information using the 
Web Setup top page. For more information, see “To display and log into the Web Setup 
page” (page 62).

(Simple Connection Profile)

(Manual Connection Profile)
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To switch the Data Projector connection profile

1 On the Data Projector’s remote controller, press the [ ] key.
This will cause the connection profile menu to appear in the projection area.

2 Use the [ ] and [ ] keys to move the highlighting to the connection profile you 
want to select and then press the [ENTER] key.

This displays the dialog box shown below.

3 Press the [ ] key to move the highlighting to “Yes” and then press the [ENTER] 
key.

This will switch to the Data Projector connection profile you highlighted in step 2 and 
then display the “Standing by for connection...” message.

The currently selected connection 
profiled is highlighted.

This is the display of the connection 
profile name after switching.
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To use Web Setup to modify the Data Projector connection profile from a 
computer

Important!
Performing the procedure below will terminate the current wireless LAN connection 
between the Data Projector and computer. To re-establish a connection, reconfigure the 
computer’s wireless LAN settings so they match those of the new Data Projector 
connection profile.

1 Perform the procedure under “To display and log into the Web Setup page” 
(page 62) to display the Web Setup top page.

2 Click the “Connection Profile” down arrow button and then select the connection 
profile you want from the menu that appears.

3 Click the [Switch] button.
This will display the following message on the Web Setup page.

4 Click the [OK] button.
This will switch the Data Projector to the connection profile you selected in step 2 and 
terminate the current wireless LAN connection between Data Projector and computer.
At this time, the message “Standing by for connection...” will appear in the projection 
area, along with the connection profile you switched with “Connection Profile” in step 2 
above.

The connection profile has been changed.
Switch the settings on the computer and then re-connect.

Download from Www.Somanuals.com. All Manuals Search And Download.



68

Assigning a Name to a Data Projector
You can use Web Setup to assign a unique name to each Data Projector, which comes in 
handy when you are using multiple projectors. The projector name you assign is displayed 
in the following locations.
• In the “Projector Name” box of the Wireless “Standing by for connection...” message
• In the “Projector Name” box of the Wireless Connection data window (page 65)
• In the “Projector Name” box of the Wireless Connection window (page 52)
• In the “Projector Name” box of the Connection dialog box (page 57)

To assign a name to a Data Projector

1 Perform the procedure under “To display and log into the Web Setup page” 
(page 62) to display the Web Setup top page.

2 In the “Projector Setup” area, click the [Edit] button.
This will display a projector setup page.

3 Enter up to 12 characters for the name into the “Projector Name” box.

4 Click the [Save] button.

Note
You also can use the projector setup page to define a connection keyword (see next 
page).
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Configuring a Connection Keyword
A connection keyword protects the Data Projector against unauthorized access when there 
are multiple computers connected over a wireless LAN using a manual connection profile. 
You can specify whether or not input of the connection keyword is required (connection 
keyword on/off) to establish a wireless LAN connection with the Data Projector from a 
computer, and you can register and modify the connection keyword as required. 
You can turn the connection keyword on or off using either Web Setup or the Wireless 
setup menu. Connection keyword registration and modification can be performed using Web 
Setup.

To modify an existing connection keyword

1 Perform the procedure under “To display and log into the Web Setup page” 
(page 62) to display the Web Setup top page.

2 In the “Projector Setup” area, click the [Edit] button.
This will display a projector setup page.

3 Enter up to 16 single-byte characters or symbols into the “Connection Keyword” 
box.

4 Select “On” when you want to require input for connection from a computer to 
the Data Projector over a wireless LAN, or “Off” to turn off the connection 
keyword.

5 After the settings are the way you want, click the [Save] button.

To turn connection keyword input on or off on the Data Projector

1 While Wireless is shown in the projection area, press the [MENU] key on the 
Data Projector’s remote controller.

This will display the setup menu.

2 Press the [ ] key to move the highlighting to “USB” and then press the 
[ENTER] key.

3 Press the [ ] key once to move the highlighting to “Setup” and then press the 
[ENTER] key.

This will display the Wireless setup menu with “Connection Keyword” highlighted.
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4 Use [ ] and [ ] to select “On” or “Off”.
Selecting “On” will require connection keyword input whenever a computer tries to 
connect to the Data Projector.

5 To exit the Wireless setup menu, press the [ESC] key.

To connect to the Data Projector from a computer over a wireless LAN 
when connection keyword input is required

1 On the computer, perform the required operation to connect to the Data 
Projector.

To do this, perform the procedures under “Establishing a Wireless LAN Connection with 
Multiple Computers Using a Manual Connection” (page 53).

2 On the Wireless Connection window, click the  button.
This will display a dialog box for inputting a connection keyword.

3 Enter the connection keyword that is preset for the Data Projector and then click 
the [OK] button.

If the input connection keyword is correct, a wireless LAN connection will be established 
between the Data Projector and computer and the computer screen contents will be sent 
to the Data Projector.
An error dialog box will appear if the input connection keyword does not match the one 
that is assigned to the Data Projector. Click [OK] to close the error dialog box and then 
enter the connection keyword again.
If you input the wrong keyword three times in a row, the connection keyword input dialog 
box will not appear again when you click the [OK] button on the error dialog box. To 
display the connection keyword input dialog box again, click the  button.
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Modifying Data Projector Manual Connection Settings
The following are example cases in which you may want to modify Data Projector manual 
connection settings.
• When you want to configure Data Projector settings to be compatible with information 

configured on the wireless LAN access point you are using
• When you want to enhance security by modifying initial default settings
• When you want to establish a wireless LAN connection using a fixed IP address
• When using another manufacturer’s wireless LAN adapter or a wireless LAN adapter built 

into the computer
You can modify manual connection settings using Web Setup.

To modify Data Projector manual connection settings

Important!
Performing the procedure below to modify the connection profile being used for the 
wireless LAN connection between the Data Projector and computer will terminate the 
current connection. To re-establish a connection, reconfigure the computer’s wireless LAN 
settings so they match those of the new Data Projector connection profile.

1 Perform the procedure under “To display and log into the Web Setup page” 
(page 62) to display the Web Setup top page.

2 In the “Connection Profile Setup” area, click the [Edit] button.
This will display a dialog box for configuring the connection profile.

3 Click a tab (Manual Connection 1, 2, or 3) to display the connection profile 
whose settings you want to modify.

4 Configure the settings on the tab that is displayed.
For details about each of the settings on the dialog box, see “Manual Connection Setting 
Reference” (page 77).

5 To save your settings, click the [Save] button.
This should cause the message “Your settings have been saved.” to appear.
If there is anything wrong with the settings, the message “Some input items are missing.” 
will appear. If this happens, click [Back] in the lower left corner of the page to return to 
the connection profile setup page, and correct the settings as required. When checking 
your settings, refer to “Manual Connection Setting Reference” (page 77).

Note
To use a modified connection profile for a wireless LAN connection, you will need to 
switch to the profile (unless you modified the connection profile that you are currently 
using). For details, see “To switch the Data Projector connection profile” (page 66).
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Creating a Computer Connection Profile
After you modify the settings of the Data Projector’s manual setting profile, you will also 
need to modify the existing wireless LAN connection settings (connection profile) of the 
computer accordingly, or you will have to create a new connection profile. This section 
explains the procedure for using Wireless Connection to create a new profile or to modify 
the existing profile of a computer that has a CASIO YW-2 wireless adapter connected.

Important!
For the required computer wireless LAN connection settings when you are using another 
manufacturer’s wireless LAN adapter or the computer’s built-in LAN adapter, see the 
user documentation that comes with the wireless LAN adapter or the computer you are 
using.

To create a new computer connection profile

Note
This procedure shows how to create a new computer connection profile to match 
modifications made in the settings of the Data Projector’s connection profile named 
“Manual Connection 3”. In this example, the projector’s name (page 68) is “Projector A”.

1 Perform the procedure under “To modify Data Projector manual connection 
settings” (page 71) to modify Data Projector’s “Manual Connection 3” profile 
settings as shown below.

For details about each of the settings on the dialog box, see “Manual Connection Setting 
Reference” (page 77).

Dialog Box Item Setting

Profile Name MeetingRoomB

SSID ROOM_B

Access Mode Access Point

Security Setup WPA-PSK

WEP Key Format ASCII/128bit

WPA/WPA2 Encoding TKIP

WEP Key/WPA/WPA2 Pass Phrase 1234567890abc

DHCP Off

IP Address 192.168.10.1

Subnet Mask 255.255.255.0

Default Gateway (To match wireless LAN access point settings.)

Channel Auto 
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2 Perform the procedure under “To switch the Data Projector connection profile” 
(page 66) to switch the Data Projector connection profile to “Manual Connection 
3”.

This will cause the “Standing by for connection...” screen to appear in the projection 
area. Confirm that the screen shows “Manual Connection 3” for the connection profile.

3 On the computer that has the YW-2 wireless adapter connected, double-click the 
 icon to display the Wireless Connection window.
This step is not necessary if the Wireless Connection window is already displayed.

4 On the Wireless Connection window, select “Switch Connection Profile” on the 
“Connection” menu.

This will display a dialog box for switching the connection profile.

5 Click the [New] button.
This will display a dialog box for configuring a new manual connection profile.

6 On the dialog box for configuring the manual connection setup, configure the 
settings so they are the same as those that you configured for Manual 
Connection 3 in step 1 of this procedure.

For the IP address, use any address that is different from the Data Projector’s address 
(192.168.10.1). For example, you could use 192.168.10.2.
For details about each of the settings on the dialog box, see “Manual Connection Setting 
Reference” (page 77).
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7 After configuring all of the settings you want, click the [Register] button.
This will register your settings as a new connection profile and return to the connection 
profile switching dialog box in step 1.

8 Click the [Close] button.
This closes the connection profile switching dialog box and displays the dialog box shown 
below.

When the computer finds the Data Projector, the display will change to a dialog box like 
the one shown below for selecting the connected device.

9 Check to make sure that “Projector A” is highlighted for the projector name and 
then click the [OK] button.

This will establish a wireless LAN connection between the computer and Data Projector.
This will close the connected device selection dialog box and display the Wireless 
Connection dialog box on the computer screen.

10 On the Wireless Connection window, click the  button.
This will cause the contents of the computer screen to be projected so they fill the 
entire projection area.
For details about Wireless Connection window operations and Data Projector remote 
controller operations you can perform after establishing a connection, see “Using Wireless 
LAN for Projection” (page 88).
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To modify an existing computer connection profile

1 On the computer that has the YW-2 wireless adapter connected, double-click the 
 icon to display the Wireless Connection window.
This step is not necessary if the Wireless Connection window is already displayed.

2 On the Wireless Connection window, select “Switch Connection Profile” on the 
“Connection” menu.

This will display a dialog box for switching the connection profile.

3 Click the “Profile Name” down arrow button and then select the connection 
profile you want to modify from the menu that appears.

4 Click the [Change Setup] button.
This will display a dialog box for configuring a new manual connection profile.

5 On the dialog box, modify the settings as required.
For details about each of the settings on the dialog box, see “Manual Connection Setting 
Reference” (page 77).

6 After configuring all of the settings you want, click the [Register] button.
This registers the settings you modified in the manual setting in step 5 and returns to 
the connection profile switching dialog box.

Deleting a Computer Connection Profile
You can use the procedure in this section to delete computer connection profiles you 
created with Wireless Connection when you no longer need them. Wireless Connection can 
also be used to delete the default connection profiles (Initial Setup 1, 2, and 3).

To delete a computer connection profile

1 On the computer that has the YW-2 wireless adapter connected, double-click the 
 icon to display the Wireless Connection window.
This step is not necessary if the Wireless Connection window is already displayed.

2 On the Wireless Connection window, select “Switch Connection Profile” on the 
“Connection” menu.

This will display a dialog box for switching the connection profile.

3 Click the “Profile Name” down arrow button and then select the connection 
profile you want to delete from the menu that appears.

4 After the settings are the way you want, click the [Delete] button.

5 To close the connection profile switching dialog box, click the [Close] button.
This will return to the Wireless Connection window.
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Assign a User Name to a Computer for Projection
User names make it possible to identify each computer when multiple computers are 
connected to the Data Projector at the same time. The user name assigned to a computer 
will appear in the projection area when the computer’s screen contents are projected. Use 
Wireless Connection to assign a user name to each computer.

To assign a user name to a computer for projection

1 On the Wireless Connection window, select “Options” on the “Tools” menu.
This will display a dialog box for configuring the option setting.

2 In the “User Name” box, enter the user name for the computer.
Input up to 12 characters.

3 Click the [OK] button.
This will register the user name.

Specifying the Quality of Images Sent from a Computer
Use the procedure below to specify the quality of images you send from a computer. The 
“High-quality” setting provides better image quality, while the “Normal-quality” setting makes 
the send operation faster.

To specify image quality

1 On the Wireless Connection window, select “Options” on the “Tools” menu.
This will display the [Options] dialog box. 

2 Under [Quality], select the quality setting you want. 

3 When the setting is the way you want, click [OK].
This will apply your setting.
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Manual Connection Setting Reference
This section provides detailed explanations of all of the manual connection settings.
• See “To modify Data Projector manual connection settings” (page 71) for information 

about how to change Data Projector manual connection settings.
• For information about creating a computer manual connection setting profile for wireless 

LAN connection with the Data Projector, refer to “To create a new computer connection 
profile” (page 72). For information about modifying a manual connection setting profile, 
refer to “To modify an existing computer connection profile” (page 75).

Data Projector Manual Connection Setting 
Screen
Connection Profile Setting Page

Computer Manual Connection Setting Screen
Wireless Connection Manual Connection Setting 
Dialog Box
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Note
The initial default setting for each item is indicated by an asterisk (*).

Setting Name Description

Profile Name This is a name assigned to identify each individual manual connection.
Input up to 10 characters.

SSID Wireless network ID name. This is normally referred to as the SSID, ESS-ID, 
or network name. Input up to 32 single-byte alphanumeric characters. 

Access Mode Specifies either wireless LAN connection through an access point or direct 
connection between the Data Projector and computer without going through 
an access point.

Access Point:
Specifies wireless LAN connection through an access point.

Ad Hoc*:
Specifies direct wireless LAN connection between the Data Projector and 
computer. 

Security 
Setup

Specifies whether or not communication over the wireless LAN connection is 
encrypted. A setting to select the encryption type is also provided. The Data 
Projector supports three types of encryption: WEP, WPA-PSK, and WPA2-
PSK.

Off*:
Encryption turned off.

WEP:
Turns on WEP encryption. When this option is selected, you also must 
specify a WEP key format and a WEP key.

The letters “WEP” stand for “Wired Equivalent Privacy”. It is a security 
protocol that uses a character string to encrypt data and protect against 
unauthorized access to wireless communications.

WPA-PSK:
Turns on WPA-PSK encryption. When this option is selected, you also must 
specify a WPA/WPA2 encoding and a WPA/WPA2 pass phrase.

The letters “WPA” stand for “Wi-Fi Protected Access”. Like WEP, it is a 
security protocol that encrypts communication data. WPA uses an 
automatically generated encryption key that is changed at preset 
intervals, which provides stronger security than WEP.

WPA2-PSK:
Turns on WPA2-PSK encryption. When this option is selected, you also 
must specify a WPA/WPA2 encoding and a WPA/WPA2 pass phrase.

WPA2 is a new standard of WPA.

Note
You cannot select WPA-PSK or WPA2-PSK when “Ad Hoc” is selected 
for the “Access Mode” setting.

WEP Key 
Format

You only need to configure this setting when “WEP” is selected for “Security 
Setup”.
You can specify any one of the following formats for input of the WEP key.

ASCII/64bit, ASCII/128bit, HEX/64bit, HEX/128bit*
For more information about inputting the WEP key using the format specified 
here, see the “WEP Key / WPA/WPA2 Pass Phrase” item below.
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WPA/WPA2 
Encoding

You only need to configure this setting when “WPA-PSK” or “WPA2-PSK” is 
selected for “Security Setup”.

TKIP*:
Select “TKIP” as the encryption type.

AES:
Select “AES” as the encryption type.

WEP Key/
WPA/WPA2 
Pass Phrase

Use this input box to enter a WEP key or WPA/WPA2 pass phrase. What 
you need to input depends on the encryption type you selected for “Security 
Setup”.

When “WEP” is selected for “Security Setup”
Enter the WEP key. The WEP key character string should be input using 
one of the following formats, in accordance with the “WEP Key Format” 
setting.

ASCII/64bit
Five or more single-byte alpha-numeric characters (Example: “MyKey”)

ASCII/128bit
13 or more single-byte alpha-numeric characters (Example: 
“MyKey12345678”)

HEX/64bit
Hexadecimal value up to 10 digits long (Example: 11AA22BB33)

HEX/128bit
Hexadecimal value up to 26 digits long (Example: 
00112233445566778899AABBCC)
When “WPA-PSK” or “WPA2-PSK is selected for “Security Setup”

Enter the WPA/WPA2 pass phrase (encryption key).
Enter the same encryption key that is currently set on the wireless LAN 
access point to which you are planning to connect. You should enter at 
least eight and up to 63 single-byte characters, or a hexadecimal value up 
to 64 digits long

DHCP Specifies whether the IP address that is set manually on the device being 
configured (Data Projector or computer) or the IP address assigned 
automatically by the DHCP server should be used during wireless LAN 
connection.
On*:

Specifies use of the IP address assigned automatically by the DHCP 
server. You do not need to configure the “IP Address”, “Subnet Mask”, or 
“Default Gateway” settings when this option is selected.

Off:
Specifies use of the manually set IP address. You need to configure the 
“IP Address”, “Subnet Mask”, and “Default Gateway” settings when this 
option is selected.

IP Address Configuration of this setting is required when “Off” is selected for “DHCP”.
Enter the IP address that is assigned to the Data Projector/computer. The IP 
address consists of four values in the range of 0 to 255, separated by 
periods (such as 192.168.10.3).

Setting Name Description
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Subnet Mask Configuration of this setting is required when “Off” is selected for “DHCP”. 
Enter a subnet mask value, which specifies the range of the IP address of 
the subnet to which the Data Projector/computer belongs. The subnet mask 
consists of four values in the range of 0 to 255, separated by periods (such 
as 255.255.255.0).

Default 
Gateway

Configuration of this setting is required when “Off” is selected for “DHCP”. 
When “Access Point” is selected for “Access Mode”, specify the same value 
as the wireless LAN access point.

Channel Configuration of this setting is required when “Ad Hoc” is selected for 
“Access Mode”. When there is a large number of devices performing wireless 
LAN communication using frequencies in the same frequency band (2.4 GHz) 
used by the Data Projector, you can improve communication performance by 
assigning different channels to each wireless LAN network. Normally you 
should leave this item set to “Auto” (initial default setting).
Auto*:

Automatically assigns a communication channel for wireless LAN 
communication. If “Auto” is selected on the Data Projector, also select 
“Auto” for the computer as well.

1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11:
Specify a channel that should be used for wireless LAN communication. 
The same channel must be set on the Data Projector and the computer 
that will be communicating with each other over the wireless LAN 
connection.

Setting Name Description
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Returning Data Projector Wireless Settings to Their Initial 
Defaults
You can return all Data Projector Wireless function settings to their initial defaults by 
executing “Initialize Wireless Setup”. The following are the Wireless initial default settings 
configured by this operation.

To return Data Projector Wireless function settings to their initial defaults

1 While Wireless is shown in the projection area, press the [MENU] key on the 
Data Projector’s remote controller.

This will display the setup menu.

2 Press the [ ] key to move the highlighting to “USB” and then press the 
[ENTER] key.

3 Press the [ ] key once to move the highlighting to “Setup” and then press the 
[ENTER] key.

This will display the Wireless setup menu.

4 Press the [ ] key to move the highlighting to “Initialize Wireless Setup”.

Dialog Box Item Initial Default

Connection Keyword (page 69) Off (no keyword)

Show User Name Display (page 92) On

Web Setup (page 64) Enable
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5 Press the [ENTER] key.
This displays the dialog box shown below.

6 Press the [ ] key to move the highlighting to “Yes” and then press the [ENTER] 
key.

This initializes all Wireless settings.

Viewing Wireless Connection Help
To view Wireless Connection help, select “Help” on the Wireless Connection window “Help” 
menu.

Viewing Wireless Connection Version Information
To view Wireless Connection version information, select “About Wireless Connection...” on 
the Wireless Connection window “Help” menu.
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Whenever you experience problems with the wireless LAN connection between the Data 
Projector and the computer, check the following points first. 

Check the following on the computer. 
• Did you disable “Wireless Network Connection” before connecting the YW-2 

wireless LAN adapter to your computer’s USB port? 
On the Windows Control Panel, click “Network Connections” (“Network and Dial-up 
Connection” in the case of Windows 2000). If you see “Wireless Network Connection” on 
the window that appears, right-click the icon and then click “Disable”. If you see “Local 
Area Connection” on the same window, it is recommended that you perform the same 
operation as above to disable it as well. 

• Is a wireless LAN utility other than Wireless Connection (which comes with the 
Data Projector) running? 
If so, shut down the other utility. 

Check the following on the Data Projector. 
• Is the same connection profile selected on the computer and on the Data 

Projector? 
Wireless LAN connection is not possible when different connection profiles are selected 
on the computer and the Data Projector (such as “Manual Connection 1” on the 
computer and “Simple Connection 1” on the Data Projector). Make sure the same 
connection profile is selected on both.

Also check the following. 
• Are the Data Projector and computer too far apart or are they separated by a wall 

or other barrier? 
Try moving the Data Projector and computer so they are closer to each other. 

• Is a microwave oven or a Bluetooth device being used nearby? 
Operation of a device that uses the 2.4 GHz frequency band (which is the same 
frequency band as the IEEE802.11b wireless standard used by the Data Projector) in the 
vicinity of the Data Projector can cause radio interference, resulting in a wireless 
communication error. Avoid using the nearby microwave oven or Bluetooth device when 
performing Data Projector wireless LAN communication. 

If the above countermeasures do not resolve your problem, try the following depending on 
the problem you are experiencing. 

Wireless LAN Connection Troubleshooting
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You cannot establish a Manual Connection between the Data Projector and 
a single computer or multiple computers. 
Except for the IP address setting, all of the settings configured for the Data Projector and 
the computer(s) must match in order to establish a Manual Connection. Use the following 
procedures to display and check the Data Projector and computer settings. If there are any 
differences in the settings, change the settings on the computer(s) so they match. It is 
important to remember here, however, that the IP addresses must be different. 

To check Data Projector settings
Press the [FUNC] key, confirm that “View Connection Info” is highlighted, and then press 
the [ENTER] key. 

To check computer settings

1 On the Wireless Connection window, select “Switch Connection Profile” on the 
“Connection” menu. 

2 On the connection profile switching dialog box that appears, click the “Profile 
Name” down arrow button and select the connection profile whose settings you 
want to view. 

3 Click the [Change Setup] button. 
This will display a dialog box for configuring a new manual connection profile. Use the 
dialog box to check the settings and make any changes that are required. 

Important!
When establishing wireless LAN connections between the Data Projector and multiple 
computers, the Data Projector and each of the computers must have their own unique 
IP addresses. For example, you could assign the IP address 192.168.1.100 to the Data 
Projector, and assign the following IP addresses to the computers: 192.168.1.10, 192. 
168.1.20, 192.168.1.30, etc. 
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When you establish a wireless LAN connection between the Data Projector 
and a computer, it takes a log of time before the contents of the computer 
screen is projected. 
It can take some time for a wireless LAN connection to be established between the Data 
Projector and computer if any other network connection besides the wireless network 
connection used by the YW-2 wireless adapter is enabled on the computer. If this 
happens, perform the following steps to disable the other network connections. 

1 On the Windows Control Panel, click “Network Connections” (“Network and Dial-
up Connection” in the case of Windows 2000). 

This will display a “Network Connections” window (“Network and Dial-up Connection” 
window). 

2 On the window, right click any wireless network connection that is not the one 
being used by the YW-2 wireless adapter, and then click “Disable” on the 
shortcut menu that appears. 

The wireless network connection used by the YW-2 wireless adapter is the one with the 
adapter name “NB 802.11g Wireless LAN USB Adapter (3887A)”. Disable all wireless 
network connections that have any other name. 

3 If you see a “Local Area Connection” on the window, right-click its icon and 
then click “Disable” on the dialog box that appears. 

Download from Www.Somanuals.com. All Manuals Search And Download.



86

The wireless LAN connection between the Data Projector and computer 
keeps dropping. 
This can be caused by the following.  
• Data communication can slow down and the connection may tend to drop when the 

Data Projector and computer are far from each other (in different rooms, on different 
floors, etc.) Move the Data Projector and computer as close together as possible.  

• Operation of a device that uses the 2.4 GHz frequency band (which is the same 
frequency band as the IEEE802.11b wireless standard used by the Data Projector) in the 
vicinity of the Data Projector can cause radio interference that results in a wireless 
communication error. Avoid using the nearby microwave oven or Bluetooth device when 
performing Data Projector wireless LAN communication. 

After checking the above two points, select [Exit] on the [Connection] menu of the Wireless 
Connection window to exit Wireless Connection, and then restart Wireless Connection.

You cannot display the Web Setup page
The Web Setup page can be displayed only while there is a wireless LAN connection 
between the Data Projector and computer. Use a Simple Connection or Manual Connection 
to establish a wireless connection between the Data Projector and computer, and then 
display the Web Setup page. For more information, see “Web Setup” (page 62). 
If the Web Setup page does not appear even through there is a wireless LAN connection 
between the Data Projector and computer, check the following points. 
• The Web Setup of the Data Projector may be disabled. Use the procedure under “To 

enable and disable Web Setup” (page 64) to check the current setting. If it is “Disable”, 
change it to “Enable”. 

• The browser you are using may be configured to use a proxy server. This can make it 
impossible to display the Web Setup page, and so the proxy server settings should be 
canceled. See the help and other user documentation for your browser for information 
about proxy server settings.
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This section provides detailed information about the Wireless Connection window menu 
commands and buttons.

Wireless Connection Menus and Button Reference

To do this:
Perform this menu 
operation:

Or click this 
button:

Use the currently selected connection profile to open a 
wireless LAN connection between a computer and the 
Data Projector

[Connection] - [Connect]

Terminate a wireless LAN connection between a 
computer and the Data Projector

[Connection] - 
[Disconnect]

On the computer, switch the connection profile used 
for wireless connection between a computer and the 
Data Projector 

[Connection] - [Switch 
Connection Profile] –

Terminate the wireless LAN connection between a 
computer and the Data Projector and quit Wireless 
Connection

[Connection] - [Exit] –

Select the mouse cursor shape for the projection 
screen or turn mouse cursor display off 

[Tools] - [Mouse Cursor 
Emulation]

Display the Wireless Connection option setting dialog 
box (for specifying a user name or to display the Web 
Setup page)

[Tools] - [Options] –

Display the Web Setup page –
Pause computer screen contents as they are being 
projected –
Project computer screen contents –
Stop projection of computer screen contents while 
maintaining the connection –
View Wireless Connection Help [Help] - [Help] –
View Wireless Connection version information

[Help] - [About Wireless 
Connection...] –
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This section explains operations you can perform after a connection is established between 
the Data Projector and computer.

Operations while a Single Computer is Connected to the 
Data Projector over a Wireless LAN

To project computer screen contents
On the computer screen, click the  button on the Wireless Connection window.

• This will send the contents of the computer screen to the Data Projector, which will 
project it. The color of the  button at this time will change from black to green.

Note
The mouse cursor is not displayed while computer screen contents are being projected. 
To display the mouse cursor in the projection area in this case, use the Wireless 
Connection’s mouse cursor emulation feature. For details, see “To display a mouse 
cursor in the projection area” (page 89).

Using Wireless LAN for Projection

For this type of connection: Refer to this section of this manual:

Single computer connected to the Data 
Projector over a wireless LAN

“Operations while a Single Computer is Connected to the 
Data Projector over a Wireless LAN” (below)

Multiple computers connected to the 
Data Projector at the same time over 
a wireless LAN

“Operations while a Single Computer is Connected to the 
Data Projector over a Wireless LAN” (below) and 
“Operations while Multiple Computers are Connected to the 
Data Projector over a Wireless LAN” (page 91)
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To pause computer screen contents as they are being projected
On the computer screen, click the  button on the Wireless Connection window. This will 
cause the  button color to change from black to green, and pause the screen contents 
in the projection area.
To unpause projection of the mage, click the  button.

To stop projection of computer screen contents while maintaining the 
connection
On the computer screen, click the  button on the Wireless Connection window. This will 
cause the  button color to change from black to green the projection area to go black.
To resume projection of the image, click the  button.

To display a mouse cursor in the projection area

1 Click the  button or select [Mouse Cursor Emulation] on the [Tools] menu.
This will display a mouse cursor emulation dialog box.

2 Select the type of mouse cursor you want to use and then click the [OK] 
button.

This will display the selected mouse cursor in the projection area. The mouse cursor will 
be located at the same location as the mouse cursor on the computer screen.
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Note
The mouse cursor displayed using mouse cursor emulation is not the same mouse 
cursor as displayed on the computer screen. Wireless Connection detects the location 
of the mouse cursor on the computer screen and displays the mouse cursor 
emulation in the projection area.

If you do not want a mouse cursor in the projection area, select “Off” in step 2 
above.

To terminate the wireless LAN connection between a computer and Data 
Projector from the computer
On the computer screen, click the  button on the Wireless Connection window, or select 
“Disconnect” on the “Connection” menu.
This will terminate the wireless LAN connection between the computer and Data Projector 
and display “Standing by for connection...” in the projection area.

To restore the wireless LAN connection between a computer and Data 
Projector from the computer
On the computer screen, click the  button on the Wireless Connection window, or select 
“Connect” on the “Connection” menu.
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Operations while Multiple Computers are Connected to 
the Data Projector over a Wireless LAN
While multiple computers are connected to the Data Projector over a wireless LAN, you 
can check which computer’s screen contents currently are being projected, and you can 
switch projection between computer screens as required. Use the Data Projector’s remote 
controller to perform these operations.

To check which computer’s screen contents currently are being projected.
On the Data Projector’s remote controller, press the [ ] key. This will display the user 
name of the computer whose screen contents are currently being projected.

To switch projection from the screen contents of one computer to another

1 While the screen contents of one of the computer’s connected over a wireless 
LAN connection are being projected, press the [ ] key on the Data Projector’s 
remote controller.

This will switch to the user menu that shows thumbnails of the screen contents of all the 
connected computers along with their user names, as shown below.

2 Use the cursor keys on the Data Projector’s remote controller to move the 
highlighting to the thumbnail you want to select.

3 Press the [ENTER] key or the [ ] key.
This will cause the contents of the selected computer screen to be projected so they fill 
the entire projection area.
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To turn display of user names in the projection area on and off

Note
Under initial default settings, the user name is displayed in the upper left corner of the 
projection area whenever you switch projection from the contents of one computer 
screen to another, or when a single computer is connected to the Data Projector over 
a wireless LAN.

1 While Wireless is shown in the projection area, press the [MENU] key on the 
Data Projector’s remote controller.

This will display the setup menu.

2 Press the [ ] key to move the highlighting to “USB” and then press the 
[ENTER] key.

3 Press the [ ] key once to move the highlighting to “Setup” and then press the 
[ENTER] key.

This will display the Wireless setup menu.

4 Press the [ ] key to move the highlighting to “Show User Name Display”.

5 Use [ ] and [ ] to select “On” (user name displayed) or “Off” (user name not 
displayed).

6 To exit the Wireless setup menu, press the [ESC] key.
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Performing a Presentation Using the YC-400 
Document Camera

This section explains how to connect the CASIO YC-400 Multi PJ Camera System (document 
camera) to the Data Projector in order to project the images of documents placed on the 
document stage of the document camera. The Data Projector’s built-in application named YC 
Camera is used to project document images.

Important!
A YC-400 document camera can be connected to the Data Projector only if the camera 
is running firmware version 1.1 or higher. For information about checking the firmware 
version of your YC-400 document camera, visit the CASIO website at:
http://world.casio.com/projector/download/en/yc_400_firmup/

YC Camera is an application built into the Data Projector that makes it possible to control 
the YC-400 document camera from the Data Projector. With the YC Camera application you 
can project the image of documents placed on the document stage of the document camera. 
Connecting the document camera to the Data Projector’s USB port and turning on the 
document camera will cause the YC Camera application to start up automatically.

Connecting the Document Camera to the Data Projector
This section provides the basic steps you need to perform in order to connect the 
document camera to the Data Projector and project the image of documents placed onto 
the document camera’s document stage.

Important!
The procedure below assumes that the Data Projector’s plug-and-play feature is turned 
on (which is the initial default setting). If you have turned off plug-and-play, turn it back 
on before performing the procedure below. For more details about the plug-and-play 
setting, see “Setup Menu Contents” in the User’s Guide.

YC Camera Application Function and Operation 
Overview
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To connect the document camera to the Data Projector and project the 
image of a document

1 Turn on the Data Projector.
Wait until the Data Projector’s POWER/STANDBY indicator is lit green.

2 Connect the document camera to the Data Projector using the USB cable that 
comes bundled with the document camera.

3 With nothing on the document stage, press the [ ] (power) button on the 
camera stand.

This will turn on the document camera, which will cause its lens to extend.
The Data Projector will recognize the document camera and start up the YC Camera 
application automatically. When the YC Camera application starts up, the Data Projector 
will project an image of the document stage along with a dialog box for adjusting the 
document camera position.

If the document camera is positioned correctly, position adjustment will end automatically 
and the dialog box will close. At this time the monitor screen (the image being picked 
up by the document camera) will be projected.
If the document camera is not positioned correctly, a message prompting you to adjust 
the document camera position will appear. Follow the instructions shown in the message 
to adjust the document camera position.

XJ-S35

Document stage

YC-400

Camera

Camera stand
USB cable
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4 Place the document whose image you want to project onto the document 
camera’s document stage.

Be sure to place the document in the center of the 
stage, and do not let any part of the document 
extend off the edges of the stage.
When placing a landscape orientation document onto 
the document stage, the top of the page should face 
towards the camera stand.
Initially the monitor image will be projected, and so 
the image will appear a bit fuzzy.

When the document camera senses that the document on the stage is not being moved, 
it will record its image and switch from the fuzzy monitor image to a high-resolution 
image (recorded image) automatically.

5 Now you can replace the document currently on the stage with another one.
This will switch to the recorded image of the next document automatically.

Note
Step 5 above is what happens while the Data Projector’s YC Camera application is 
configured with its initial default settings. The recorded image will not switch 
automatically if you have changed the “Operation Mode” setting of the YC Camera 
application to “Manual Capture”. For more information, see “YC Camera Application 
Setup Menu Contents” on page 103.

Rough (Monitor) Image Recorded Image
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This section explains the various types of projection operations you can perform with the YC 
Camera application and how to configure YC Camera application settings.

Important!
The procedures in this section assume that you have already connected the YC-400 
Document Camera to the Data Projector as explained under “Connecting the Document 
Camera to the Data Projector” (page 93), and that the Data Projector’s YC Camera 
application is running.

YC Camera Application Projection Operations
The operations in this section are performed using the YC Camera function menu, which 
appears when you press the [FUNC] key while the YC Camera application is running.

Some operations can be performed using the remote controller’s [ ], [ ], and [ ] keys.

To release the document camera shutter manually

1 Press the [FUNC] key to display the YC Camera application function menu.
The “Camera Shutter” item should be highlighted by default.

2 Press the [ENTER] key to release the document camera shutter.
This will cause the image recorded with the document camera to be projected.

Note
While a rough monitor image or recorded image is projected, you can release the 
shutter manually by pressing the [ENTER] key, without pressing the [FUNC] key.

YC Camera Application Operations
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To adjust the document camera’s zoom setting

1 Press the [FUNC] key to display the YC Camera application function menu.

2 Use the [ ] key to move the highlighting to “Camera Zoom/Focus” and then 
press the [ENTER] key.

This causes the YC Camera Zoom/Focus dialog box to appear in the projection area. 
The “Optical Zoom” item should be highlighted by default.

3 Use the [ ] and [ ] keys to adjust the document camera’s zoom setting.

4 After the zoom setting is the way you want, press the [ESC] key.
This will close the YC Camera Zoom/Focus dialog box.

To adjust document focus manually

1 Press the [FUNC] key to display the YC Camera application function menu.

2 Use the [ ] key to move the highlighting to “Camera Zoom/Focus” and then 
press the [ENTER] key.

This causes the YC Camera Zoom/Focus dialog box to appear in the projection area.

3 Press the [ ] key to move the highlighting to “Focus”.

4 Use the [ ] and [ ] keys to adjust the document camera’s focus.

5 After the focus is the way you want, press the [ESC] key.
This will close the YC Camera Zoom/Focus dialog box.
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To adjust the camera position

1 Remove all documents and objects from the document stage.

2 Press the [FUNC] key to display the YC Camera application function menu.

3 Use the [ ] key to move the highlighting to “Adjust Camera Position” and then 
press the [ENTER] key.

This displays the camera position adjustment dialog box.

4 Point the document camera downwards so the lens is pointed towards the 
document stage.

Aim the camera as instructed by the text that appears in the projection area.

When the document camera is positioned correctly, position adjustment will end and the 
dialog box will close. At this time the monitor screen (the image being picked up by the 
document camera) will be projected.

Download from Www.Somanuals.com. All Manuals Search And Download.



99

To rotate the currently projected image

Note
This operation will affect only the image that is currently being projected. The projection 
image produced the next time you release the shutter will be projected in accordance 
with the settings on the YC Camera Application Setup Menu (page 101).

1 Press the [FUNC] key to display the YC Camera application function menu.

2 Use the [ ] key to move the highlighting to “Rotate Right” and then press the 
[ENTER] key.

This will rotate the projected image 90 degrees to the right.
Instead of steps 1 and 2 above, you can also rotate the projected image by pressing 
the [ ] key.

To perform white enhancement on the currently projected image

Note
White enhancement causes the background of the projected image to be white 
enhanced, which helps to make the text on a document easier to read.
This operation will affect only the image that is currently being projected. The 
projection image produced the next time you release the shutter will be projected in 
accordance with the settings on the YC Camera Application Setup Menu (page 101).

Important!
You can perform white balance only on a projected image that has been skew 
corrected. For more information, see the note under “To perform manual skew correction 
on the currently projected image” (page 100).

1 Press the [FUNC] key to display the YC Camera application function menu.

2 Use the [ ] key to move the highlighting to “Enhance White” and then press 
the [ENTER] key.

This will enhance the white of the projected image.
Instead of steps 1 and 2 above, you can also white enhance the projected image by 
pressing the [ ] key.
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To perform manual skew correction on the currently projected image

Note
Skew correction automatically straightens the image of a document that is misaligned 
on the document stage of the document camera. Under its initial defaults, the YC 
Camera application is configured to perform skew correction automatically. You can 
also turn off auto skew correction. If you do, you can use the following procedure to 
adjust image alignment manually.

This operation will affect only the image that is currently being projected. The 
projection image produced the next time you release the shutter will be projected in 
accordance with the settings on the YC Camera Application Setup Menu (page 101).

1 Press the [FUNC] key to display the YC Camera application function menu.

2 Use the [ ] key to move the highlighting to “Skew Correction” and then press 
the [ENTER] key.

This will straighten the projected image.
Instead of steps 1 and 2 above, you can also perform skew correction of the projected 
image by pressing the [ ] key.
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Configuring YC Camera Application Setup Menu Settings
You can use the YC Camera setup menu to configure various YC Camera application 
operation settings.

To configure YC Camera application setup menu settings

1 Press the [MENU] key to display the setup menu.

2 Press the [ ] key to move the highlighting to “USB” and then press the 
[ENTER] key.

3 Press the [ ] key once to move the highlighting to “Setup” and then press the 
[ENTER] key.

This will display the YC Camera application setup menu.

4 Use [ ] and [ ] to select the menu item whose setting you want to change.

5 Press the [ ] or [ ] key to select the setting you want (so its button is ).

6 Repeat steps 4 and 5 to configure other settings, if you want.

7 After you are finished, press the [ESC] key to exit the setup menu.

Note
Anytime you change the “White Enhancement” or “Skew Correction” setting, the new 
setting goes into effect from the next image you record with the document camera after 
exiting the setup menu. Other settings go into effect as soon as you exit the setup 
menu.
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To restore all settings on the YC Camera application setup menu to their 
initial factory defaults

1 Press the [MENU] key to display the setup menu.

2 Press the [ ] key to move the highlighting to “USB” and then press the 
[ENTER] key.

3 Press the [ ] key once to move the highlighting to “Setup” and then press the 
[ENTER] key.

This will display the YC Camera application setup menu.

4 Press the [ ] key to move the highlighting to “Initialize YC Camera Setup” and 
then press the [ENTER] key.

This displays the dialog box shown below.

5 Use the [ ] key to select “Yes”.

6 To restore all the settings to their initial defaults, press the [ENTER] key.
To exit the operation without doing anything, press [ESC] instead of [ENTER].

7 After you are finished, press the [ESC] key to exit the setup menu.
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YC Camera Application Setup Menu Contents
This section provides detailed explanations of all of the items included on the YC Camera 
application setup menu. The initial default setting for each item is indicated by an asterisk 
(*).

Setting Name Description

Operation Mode Specifies whether recording of documents placed on the document stage of 
the document camera should be performed automatically or manually.
Auto Capture*:

Automatically records the image of a document whenever it is placed on the 
document stage.

Manual Capture:
Requires manual release of the shutter each time a document is placed on 
the document stage.

Monitor Screen 
Orientation 

Switches the monitor screen orientation.
Horizontal*:

Records the document on the document stage horizontally.

Vertical:
Records the document on the document stage vertically.

White 
Enhancement

Specifies whether or not white enhancement should be performed on the 
projected image.
Off*:

Turns off white enhancement.
On:

Turns on white enhancement.

Auto:
The decision whether or not to perform white enhancement is made 
automatically in accordance with the image being recorded.

Important!
White enhancement cannot be performed while the “Skew Correction” 
setting is “Off”.
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Skew Correction Specifies whether or not skew correction should be performed automatically 
on the projected image.

On*:
Turns on automatic skew correction.

Off:
Turns off automatic skew correction.

Project Document 
Monitor Image

Specifies whether or not the camera’s monitor image should be projected 
when a document is removed from the document stage.

On*:
Displays the monitor image.

Off:
Does not display the monitor image.

Initialize YC 
Camera Setup

Returns all YC Camera application setup menu items to their initial default 
settings. For details, see “To restore all settings on the YC Camera 
application setup menu to their initial factory defaults” on page 102.

Setting Name Description
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